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Preface

PREFACE

Automation Xpress, an easy to use, application development tool for use with Giga-
tronics 2400 Series Microwave Synthesizers and Automation Xpress Interface.
Automation Xpress offers fast remote operation that goes beyond just fast frequency
switching.

The innovative Auto-Programming tackles the major problems facing test programmers
today. Xpress Auto-Programming eliminates the complexity of having to write specific
code sequences needed to control the operation of the instrument.

Automation Xpress eliminates the need for you to learn the various GPIB commands.
With a click of the mouse, the Auto-Programming feature automatically records the
sequence of your actions and converts those actions into program code. Auto-
programming provides the option of seamlessly converting the recorded action
sequence into a generated program, that can be imported into to the program
environment of your choice, such as Visual C++ and Visual Basic. Auto-programming
generates the same results as the action sequence created manually. The value is a
reduction in test downtime, reduced programming costs, and greater profitability.

The key to reducing the cost of testing is faster frequency switching. The 2400 Series
Microwave Synthesizer offers unmatched frequency and power switching in list mode,
however this approach may not be suitable for some remote programming situations.
Automation Xpress combined with the Automation Xpress Interface option ensures
unmatched 2.5 ms CW frequency and power switching performance, providing fast and
flexible data exchange rates for faster testing and more device throughput.

The AXI ensures very fast remote programming using Automation
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Xpress from any ATE/TPS program to a 2400 series instrument, providing faster CW fre-
guency switching time, faster overall download, and faster function execution times of
large amounts of data. The transit and execution times for single function calls, such as
changing CW frequency are 10 X faster than sending the command via standard message
based commands. With Automation Xpress now sending large amounts of data, such as
large lists, the transit and execution times are > 100X faster as compared to SCPI. This
makes lengthy and repetitive tasks faster and more efficient, maximizing test throughput,
while minimizing testing time and system downtime. Automation Xpress provides the
tools necessary to successfully program the 2400 series. The Xpress Auto-programmer
can virtually eliminate the need for training, providing programming scripts and
sequences that are guaranteed for accuracy.

Programmers come and go, AX streamlines program development by ensuring consis-
tent and accurate code generation. Click of the mouse code generation eliminates the
chances for coding errors, resulting in increased testing confidence.
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Who should read this book?

If you are new Giga-tronics Automation Xpress and the 2400 Series Microwave Synthe-
sizer, read Getting Started to learn about the basic software Graphical User Interface and
how Automation Xpress works for programming in the Automatic Test Environment.

Getting Started explains the various Automation Xpress windows, menu selections, and
explains how to use the Automation Xpress Auto-Programming feature.

fii
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GETTING STARTED

The Automation Xpress (AX) user guides teaches you how to use and integrate Giga-tron-
ics Automation Xpress software features into your programming environment. This user
guide contains detailed information about the commands used to program the 2400
Series Microwave Synthesizer. In addition, the Automation Xpress user guide provides
descriptions for the Automation Xpress GT2400 API functions and a detailed description
of the AX Graphical User Interface (GUI).

You will learn step by step instructions for using the Automation Xpress Auto-Program-
ming feature for advanced programming in Visual Basic and Visual C++.
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1.1

Package Contents

The Automation Xpress software package includes the following software and documen-
tation:

* Automation Xpress CD-ROM
* USB Port Adapter and USB driver software (included in Automation Xpress CD).
* Automation Xpress User Guide (Part #XXXXX)

The Automation Xpress CD contains everything you need to install and run the Automa-
tion Xpress application, such as the Automation Xpress Installer, the USB device, and the
help document files.

For information about the software and hardware you need to use Automation Xpress,
see the Install ReadMe file on the CD.

To install and run Automation Xpress software and use the USB Port adapter, you must-
have the following hardware and software:

* An IBM-compatible PC

* Microsoft Windows 2000, or Window XP

o CD-ROM drive, 4X or better

* USB V.1.1 compliant port

* At least 20MB of disk space

® 128 MB RAM or greater recommended

e National 2400s |IEEE-488.2 GPIB Interface Card
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Installation and Uninstallation

Installation and Uninstallation

To install Automation Xpress software, follow the steps below:
1 Insert the Automation Xpress CD into the CD/DVD drive.
2 Click on My Computer and select the drive with the Automation Xpress CD.

3 Double click the Automation Xpressinstall_XXX.exe file.

The following installation screen will appear:

i'._¥ Giga-tronics Automation Xpress Setup ;Iglll
B W TN W 0

Welcome to the Giga-tronics
Automation Xpress Installation
Wizard

Pleaze wait whils e Wise Installabon Wizard® prepares the
‘windows Inztaller.

4 Click NEXT.
5 The Automation Xpress installation process will begin.

6 The Setup program begins installing the Automation Xpress software.
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7 In the Choose Automation Xpress destination location dialog, select the location
where you want the Automation Xpress software to be installed.

8 Click NEXT to accept the default location (recommended)
OR

9 Enter the directory location where you want the Automation Xpress software to install
and then click NEXT.

10 In the Setup Type dialog box, select the type of installation you would like to perform
and then click NEXT.

e Full Setup Type installs all the required Automation Xpress files (recom-
mended).

* Custom Setup Type allows you to choose which components you would like to
install.

11 When the Automation Xpress Installation is complete, the Setup Complete dialog
box appears. Click FINISH.

12 After Automation Xpress has successfully installed onto your PC, you can click FINISH
or continue with the USB Driver installation.
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Installing the USB Device and Drivers:

Installing the USB Device and Drivers:

The USB to Serial Cable Port Adapter provides you the simplest way to attach Notebook
or Desktop computer to the 2400 Series Microwave Synthesizer. This portable expansion
cable directly connects to your computer via a Universal Serial (USB) port. This section of
the Automation Xpress user’s guide describes how to connect adapter to your computer,
install software and hardware drivers, and attach and configure devices.

To use the USB Port Adapter, you must first install the USB Port Adapter driver software
onto your computer. Then, you can connect it to your computer and install hardware driv-
ers for the adapter’s port(s).

WARNING: YOU MUST INSTALL THE DRIVER

SOFTWARE BEFORE CONNECTING THE

ADAPTER TO YOUR COMPUTER.

OTHERWISE THE ADAPTER WILL NOT WORK CORRECTLY.

1.3.1 Installing the USB Driver with Automation Xpress Installation
e After Automation Xpress has installed, click Install USB
® Follow the instructions for the next screens

You must restart you computer for the USB Adapter driver to function. You can restart
your PC immediately or at a later time.
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1.3.2 USB Driver Installation from the Automation Xpress Directory

If the USB Adapter driver was not installed at the time of the Automation Xpress installa-
tion, it can be installed from the Automation Xpress directory.

* Using the Windows Explorer, locate the Automation Xpress directory
* Select the USB Driver folder and open

* Double click on the Setup.exe file and begin the USB driver installation

1.3.3 Removing the USB Driver

Conflicts with other USB/RS-232 drivers can occur if a similar driver is already installed or
is going to be installed. It is recommended that the same Make and Manufacturer USB
adapter be used on your PC only. To remove the USB Adapter driver, perform the follow-

ing:
* Using Windows Explorer, locate the Automation Xpress directory.
* Select the USB Driver folder and open.

* Double click on the Setup.exe file and begin the USB driver installation

The installation utility will recognize that a USB adapter has previously been installed. The
installation utility will ask if you want to remove the driver.
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1.4 Uninstall Automation Xpress

To uninstall Automation Xpress from your computer, do either following:
1 Click the WINDOWS > START button and choose SETTING > CONTROL PANEL.
2 In the control panel, click ADD/REMOVE PROGRAMS.

3 From the REMOVE PROGRAMS properties dialog box, select Automation Xpress and
REMOVE.

OR
1 Insert the Automation Xpress CD into CD drive.

2 Double click on the Automation Xpress Installation program.

3 Click on the "Uninstall Giga-tronics Automation Xpress from this computer" and click
NEXT continue.
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1.5

1.6

Starting Automation Xpress

You start Automation Xpress just as you would any software application.
To start Automation Xpress in Windows:

1 Choose START> PROGRAMS> Gigatronics> Automation Xpress. The Automation
Xpress registration window will appear.

2 You will be prompted to enter the provided License ID number located on the Automa-
tion Xpress License ID label affixed to front of the Automation Xpress CD sleeve. You
may also contact Giga-tronics directly to receive your License ID number.

3 After inputing the correct License ID number, Automation Xpress will launch.

Registering Automation Xpress

Registering your software helps Giga-tronics offer technical support and inform you
about new software developments. You can register quickly by using the registration
screen that appears when you first start Automation Xpress. In addition, you can choose
to register at any time by choosing HELP > REGISTER Automation Xpress. This registra-
tion requires that you be connected to the Internet, as it opens the Giga-tronics registra-
tion Web page. You can also register by phone, mail or email.

* Click REGISTER ONLINE, to register your Automation Xpress software online
OR
e Click REGISTER BY MAIL, to register your Automation Xpress software by mail.

* Register your software to receive notification of product updates and to be
eligible for technical support.



1.6.1

Registering Automation Xpress

Registering by mail or Fax:

® Open HELP> REGISTER BY MAIL. The Automation Xpress registration by mail
dialog box appears.

* Enter your name, address, phone, and fax in the edit boxes provided, and click
OK when finished.

® Click the PRINT REGISTRATION FORM button. Automation Xpress prints out a
copy of your completed registration form.

* Fax the form to Giga-tronics at the number that appears on the form, or mail it
to the Giga-tronics address that appears on the form.
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1.7

1.8

10

Getting Help

Automation Xpress includes complete documentation in the Help section located on the-
menu bar under Help, including all the information in this user guide, plus tutorials.

To get Help about Automation Xpress:
1 On the Automation Xpress Main window, click the HELP drop down menu.
2 The list of Help topics appear.

3 You can use the CONTENTS tab in HELP to find topics grouped by subject, or use the
INDEX tab or FIND tab to search for information by typing in a subject, title, or specific
word or phrase.

4 To return to the list of topics after reading about a specific topic, click HELP TOPICS.

Learning Automation Xpress

A variety of resources are available to help you learn Automation Xpress, including this
user manual, and a help system with tutorials you can launch from the Automation Xpress
application. The Automation Xpress Help Tutorial is a series of short, lessons that focus
on specific Automation Xpress features and operations, from the basics of how to create
and download lists to Auto-Programming.

The Automation Xpress application contains dialog boxes and ToolTips designed to
assist you in using the program. ToolTips appear when your pointer pauses over a user
interface element.
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Interfaces

Interfaces

The Series 2400 series permits data bus control in accordance with the IEEE Standard
Digital Interface for Programmable Instruments, IEEE STD 488.2. Table 1, shows the IEEE

488 standard subsets that are implemented in the 2400.

1.9.1

IEEE 488 Interface

Table 1: Implemented IEEE 488 Subsets

Subset Title 2400 Implementation
SHA1 Source Handshake Complete Capability
AH1 Acceptor Handshake Complete Capability
T8 Talker Basic Talker

TEO Extended Talker No Capability

L4 Listener Basic Listener

LEO Extended Listener No Capability

SRO Service Request Complete Capability
RL2 Remote/Local Complete Capability
PPO Parallel Poll Complete Capability
DCO Device Clear No Capability

DTO Device Trigger Complete Capability
CcO Controller No Capability

11
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1.9.2 Address Assignment

The remote control address is assigned from the front panel of the instrument. The avail-
able range of addresses is 1 through 30.

1.9.3 Command Interpretation

Multiple commands can be sent in a single message if a semicolon delimiter separates
the individual commands. Each command will be interpreted individually. Programming
in SCPI requires a colon to precede the commands following a semicolon. GT12000 com-
mand syntax only requires a semicolon to separate commands.

1.10 RS-232

12

1.10.1 Comport Settings

The default settings for the 2400 synthesizer are:

Parameter Setting
Baud Rate 115200
Data Bits 8
Parity No
Stop Bits 1
Handshake None




RS-232

There is no manual panel control for changing any of these settings. RS-232 port settings
can be changed using the Automation Xpress software or via remote commands (see
SYST:COMM commands in the SCPl command section for details). All remote commands
must be terminated with a line feed (ASCII character 10).

13
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An Overview of AX

2.1

This chapter introduces you to the Automation Xpress software, familiarizes you with the
software structure, and provides you with the basic procedures, menus, and windows you
need to know to use Automation Xpress.

Getting familiar with the work area

The Automation Xpress Main window appears automatically when the software is
launched. The Main window is easy to understand and use.The Main window consists of a
menu bar at the top of the work area, a toolbar below the menu bar, a large work area, a
navigation window, a message display window and a status bar located at the bottom.
The large work area provides an area for the multiple Automation Xpress windows to
open in. The following illustration labels each area of the Automation Xpress Main win-
dow.

15
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A. Menu B. Toolbar C. LED Indicators D. Navigation Window E.Message Window
F. Status Bar G. Work Area

2.1.1 Menu Bar

The Menu bar is the Automation Xpress command center. The Menu bar contains menus
and drop down submenus of all the commands available in Automation Xpress. The
menus will change depending on what window you are currently in.

16



2.1.2 File Menu

Getting familiar with the work area

Open
New List

Save List

Save List As

Close List
Close All Lists

Exit

Opens a saved file into the Main work area.
Creates a list in the List Controller window.

Saves the current list in the List Controller window to
a file.

Saves the current list in the List Controller window to
a new file.

Closes the current list.
Closes all the lists.

Exits the Automation Xpress Software program.

2.1.3 Edit Menu

Cut

Copy

Paste

Cuts the contents of the current selection to the
clipboard.

Copies the contents of the current selection to the
clipboard.

Pastes the clipboard information into the selection.

17
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2.1.4 View Menu

Toolbar

Status Bar
Navigation Window
Message Window

Web Browser

Show/Hide the Automation toolbar.
Show/Hide the Automation status bar.
Show/Hide the Navigation window.
Show/Hide the Message window.

Opens the Microsoft Explorer web browser.

2.1.5 Operation Menu

CW Mode

List Mode
List Editor

List Controller

Modulation

AM Modulation
FM Modulation
Pulse Modulation

Scan Modulation

Opens the CW Mode window saved file into the
Main work area.

Displays the Operations windows.
Opens the List Editor window.
Opens the List Controller window

Displays the Modulation windows. (2400M Series
Only)

Opens the Amplitude Modulation window.
Opens the Frequency Modulation window
Opens the Pulse Modulation window.

Opens the Scan Modulation window.

18



2.1.6 System Menu

Getting familiar with the work area

Interface

General Information

Opens the Connection Interface Window. This option is only available
when navigating in the Control tab.

Opens the General Information window.This option is displayed when
navigating in the Control tab.

2.1.7 Tools Menu

VC ++ Auto-Programmer

VB Auto-Programmer

Opens the Auto Programmer window to be used with Microsoft
Visual C++.

Openstthe Auto Programmer window to be used with Microsoft
Visual Basic.

19
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2.1.8 Windows Menu

Close All Closes all open windows.

Cascade Arranges all windows into a stack, with each window
offset slightly.

Tile Horizontal Arranges all windows to overlap horizontally.

Tile Vertical Arranges all windows to overlap vertically.

2.2 Toolbar

20

The toolbar contains buttons that operate as shortcuts to menu commands. Below is a
description of each button and what the button controls.The Automation Xpress Toolbar
allows you to set up the Automation Xpress Operations window. Common features pro-
vided in the Menu bar drop down menus, can also be selected by clicking on the appro-
priate icon on the Toolbar. The Toolbar also displays status LED indicators. Please see the
2 for LED information

=H =0 = swmm &S 3

Opens a list file. R Opens the List Controller window.

=

| u Saves a list to a file.

3 Opens the List Editor window.




Toolbar

@ |

3

Show/Hide the Navigation window.

Opens and closes the Message Dis-
play Area.

Opens the System Interface window.

Opens the General Information win-
dow.

Opens the Command Interpreter

Opens the CW Mode window. -ﬂ*
window.

Opens the Help Menu. Opens the Frequency Modulation

window.

Opens the Aplitude Modulation win-
dow.

Opens the Pulse Mode window.

E |8

Opens the SCAN Modulation window.

2.2.0.1 To identify a tool or control:

Position your mouse pointer over a tool or control and pause. A tool tip appears showing
the name and keyboard shortcut (if any) for the item.

2.2.0.2 To select a tool:

Click its icon in the toolbar.

21
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2.3 LED Indicators

The LED indicators ensure and deliver testing confidence. The status LED indicators dis-
plays the conditions of the communications link between the controller and the 2400, the
Lock and Level condition of the current RF setting, the source of the synthesizer time
base reference, and the state of the RF output. Control of the output is also located on
the LED Indicator Toolbar. The toggle control is used to enable or disable the generator
output. Click the RF On/Off button to enable and disable the RF output.

22
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A. No Connection

B. Unlocked

C. Unleveled

D. EXT REF

E. RF ON/OFF

F. AM LED

G. FM LED

H. Pulse LED

A green LED indicates that Automation Xpress has established Communication
with the 2400. A red LED indicates Automation Xpress is not communicating with
the 2400.

Displays Unlock status. A gray LED (normal mode) indicates the frequency is
locked. A yellow LED (warning mode) indicates that the frequency is unlocked.

Displays Unlevel status. A gray LED (normal mode) indicates that the power is
leveled. A yellow LED (warning mode) indicates that the power is unleveled.

Displays the External Reference status. A blue LED (normal mode) indicates that
an external reference is detected and the 2400 is locked to it. A gray LED (warn-
ing mode) indicates that there is no external reference.

Turns RF On/Off
A blue LED indicates the RF is on. A gray LED indicates the RF is off.

Displays the AM status. A gray LED indicates the amplitude modulator is off. A
green LED indicates the amplitude modulator is on.

Displays the FM status. A gray LED indicates that the frequency modulator is off.
A green LED indicates the frequency modulator is on.

Displays the Pulse status. A gray LED indicates the pulse modulator is off. A
green LED indicates the pulse modulator is on.
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2.4 Navigation Window

The Navigation window provides a tree structure of Automation Xpress. The Navigation
window enables you to quickly navigate between the different Automation Xpress control
windows. The Navigation window consists of two seperate tabbed menus, Control and
Service. The control and service tabs are arranged by functionality. When an item is
selected from the Navigation window, the corresponding window will open in the main
work area. You can SHOW and HIDE the Navigation window at any time by selecting
VIEW>Navigation Window. The following sections provide a detailed description on the
Control and Service Tab.

- Interface
-3 General Infa

EIE Tools

ﬂ? Command Interpreter

d Auta Programmer for SCPLM ative Script
Auto Programmer for WC++
At Programmer for WVE asic

A ] E" Contral ﬁ TWiCE

B

A. Control Tab B. Service Tab

23
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2.4.1 Control Tab

The Control tab is located on the bottom of the Navigation window. The Control tab
allows you to switch between the Navigation window and the Service window. The Ser-
vice window is an option based feature.

2.4.1.1 Operation Control Windows

Clicking the Operation Icon will expand the Operation menu and display it's sub-items.
An additional click will hide the Operation sub-items.The CW Mode, List Mode, and
Modulation windows are available from the operation menu.

2.4.1.1.1 CW Mode Window
The CW Mode window combined with the List Controller window provides a

powerful combination for faster and more efficient synthesizer operation. Unlike the com-
mon front panel operation, the CW Mode leverages the streamlined Windows familiar
environment, improving testing throughput and performance. In CW Mode you can set
the frequency and power quickly with your mouse. Eliminate the tedious task of entering
numbers individually from the front panel. With a click of your mouse, you can send com-
mands directly to the 2400 effortlessly.



M W Mode

A —Frequency

Sy
B [10.000 Stz o]

C —Power Level
A
00.00 3

Navigation Window

=10l x|

Attenuation E
= Auto

& Manual

Manual Attenuation:

b =1 D

A. Frequency

B. Frequency Unit

C. Power Level

D. Manual Attenuation

Lets you input CW frequency directly or use the up/down
arrow keys to change the value of the frequency.

Lets you select the units for frequency.

Lets you input power directly or use the up/down arrow keys to
change the value of the power.

Lets you select the manual attenuation value when the manual atten-
uation radio button is selected under Attenuation. After the manual
attention radio button is selected you can then set the amount of
attenuation using the Attenuation drop down box. In manual attenua-
tion mode, the output power range will be limited to a 45 db settable
range around the attenuator.

25



An Overview of AX

26

E. Attenuation This section controls the step attenuator state when option 26 is
installed in the 2400 synthesizer. The attenuator can be set to auto-
matically switch or to be controlled manually. The step attenuator has
a 90 dB range and switches in 10 dB steps. The maximum settable
range in automatic mode is -110 dBm to +25 dBm. The maximum
settable range in manual mode is 40 dB.

Auto Selecting auto attenuation causes the step attenuator to automati-
cally switch at specific power levels for the full range of the synthe-
sizer.

Manual Selecting manual attenuation control prevents the step attenuator

from automatically switching to a new state when a new
power level is selected.

2.4.1.1.2 List Mode

The List Mode consists of two distinct list operation windows, the List Controller window
(see 2) and the List Editor window (see 2). Under List Mode you can utilize the List Con-
troller window and List Editor window to create a new lists or load an existing list into the
Automation Xpress program. There is no limitation for the number of lists stored in Auto-
mation Xpress, however only one list can be stored in the 2400.

2.4.1.1.3 List Controller Window

The List Controller window is used to manage and run lists. In the List Controller window,
you can create a new list or open a file to load a list. The List Controller also allows you to
specify how a list is executed by controlling features such as step time,repeat mode and
trigger type. The list can be edited using either this window or the List Editor window.
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A. List Table The list table displays all existing list names. Here you can select the

B. Sweep Direction

current running list. You can also select a new list from the File Menu
to add a new list file name to the box or right click your mouse button
to add a new list name to the box. Select Open List from File Menu to
add a list file name with the path to the box.

Lets you set the direction of the list sweep. The list can be swept in
forward or reverse direction
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C. Repeat Type

Single Step

Single Sweep
Continuous

D. Trigger Type
BNC

GPIB Command

Group Execution

E. Current List Points

Add Before

Update

Add After

Delete

Lets you set the repeat list mode parameters for the current list. This
determines how a list will be executed.There are three repeat mode
options to select from:

Lets you execute the list one point at a time. Each point in the list is
executed for each trigger received.

Lets you execute the entire list for one trigger received.

This option will immediately execute the current running list, repeat-
ing it indefinitely.

Sets the type of trigger to initiate a list.

Sets the trigger type to BNC. A list will be triggered whenever a TTL
signal is received at the external Trigger In BNC on the rear panel of
the 2400.

Sets the trigger type to GPIB. Clicking the trigger button wil
then issue a single 2400 trigger.

Sets the trigger type to Group Execution. Clicking the trigger
button will trigger all 2400s on the GPIB bus.

The Current List Point field allows you to modify an individual
list point in the active list.

Lets you add a list point before the selected list item in theList Data
Field.

Lets you modify the frequency and power of the selected list
item in the List Data Field. First, select the list point you would
like to modify, then modify the frequency and power input
parameters.

Click to add a list point after the selected list item in the List
Data Field.

Click to delete the selected list point in the current list.
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F. BNC Sync Out

Frequency

Power

G. List Data Field
H. Sync Out Delay
I. RF Off Time (ms)
J. Step Time

K. Enable SCPI

L. Trigger Button

M Download List

BNC sync out can be set for every list point. (i.e, sync out pulse is
generated in checked points).

Lets you input a frequency value for a newly added list point. Fre-
quency units are in MHz.

Lets you input a power value for a newly added list point.Power units
are in dBm.

Displays individual list point information of the active list.

Sets the delay of the sync output. Units are in (ms).

Sets the step time for all list points. Units are in (ms).

Click to trigger the list. The type of trigger is defined by the
trigger type.

Downloads the selected list to the 2400.

2.4.1.1.4 List Editor Window

The List Editor window provides a useful way to create or insert a range of list points to
your current running list. The List Editor window contains two tabbed sets of controls: List
Range and Selected Points. The List Editor edits the list that is currently selected in the

List Controller window.

List Range Tab

Clicking on the List Range tab will open all the List Range controls. The List Range con-
trols lets you add a range of points that step in value from a starting to an ending value.
This range of points can be a frequency range at a specific power value or a power range
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at a specific frequency value. In addition, you can choose to add these points above or
below or even to replace the point/s selected in the List Controller window.

3 wist Editor =10] ]
List Range | _Sslected Pairis |
A Rarge Type —BReplazement—— J
% By Frequency " By Power [dBm] ‘ (+ Replace al
" Inseit before
B Start Star € Inselt after
|1.DDDDED [GH =] [ oo
Step Time [ms) I

C Siop Slop |2 .0od

[oooocoo fere =] | [i0.00

—lncrzment option= H
D Siep Step {= Gtep
{100.000000 [MHe = | 0100 B of points
E FPower [dEm)| Frzquenzy [MHz] # of List Pointe G

|c|3.un 100000000 .

F —2B App

A. Range Type Lets you create or insert a frequency or power list range.

B. Start Input Field Lets you input the list range starting point.

C. Stop Input Field Lets you input the ending list range point.

D. Step Input Field Lets you input the step parameter for list creation.

E. Power/Frequency Input Lets you set the power or frequency for all created list points.
F. Apply Button Updates the current list with the new list range information.
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G. Replacement Lets you select the replacement type for adding list Points.
There are three list replacement options:

Replace Selecting this option will replace your current running list with
the newly configured list.

Insert Before Selecting this option will insert the new range of list points
before the selected list item in the List Data Field.

Insert After Selecting this option will insert the new range of list points
after the selected list item in the List Data Field.

H. Step Time (ms) Sets the step time for all list points. Units are in (ms).
I. Increment Option Lets you insert list points by either step size or by the number
of list points.
Step Lets you specify the step size for list creation.
# of Points Lets you specify the number of points for the list range. Wave-
Maker determines the step size of the list using the following
formula:

STOP PARAMETER - START PARAMETER
# OF POINTS

J. # of List Points Lets you enter the number of list points for list range calculation.

Selected Point Tab description

Clicking on the Selected Points tab will display allof the Selected Point controls. The
Selected Point controls enables you to alter the frequency and power values of the points
selected in the List Controller window. You can also select or unselect BNC Sync Out for
the selected points.
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A. Selected Point #

B. Frequency Input Field

C. Power Input Field
D. BNC Sync Out

E. Apply

F. Delete Points

Lets you select a list point(s) from the List Controller window and edit
the frequency and power parameters

Lets you set the frequency for the selected list point(s) in the List
Controller window.

Lets you select the power for the selected list point(s).
Lets you set the BNC Sync Out for the selected point(s).
Applies the changes to the selected list point(s).

Deletes the selected point(s).
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2.4.2 Modulation

Clicking on the Modulation Icon will expand the Modulation menu and display it's sub-
items. An additional click will hide the Modulation sub-items.

2.4.2.1 Aplitude Modulation (AM)

Double clicking on the Amplitude Modulation icon will open the Amplitude Modulation
window. The Amplitude Modulation window allows a user to enable or disable Amplitude
Modulation. In addition the user can select an External or Internal Source. For an External
Source the user can specify the AM Mode and the Scaling. For an Internal Source the user
can specify the AM Mode, the Waveform, the Depth, and the Frequency.

=% Amplitude Modulation _ |EI|1|
@

B — Sensitvit.  [i0.0 oY | o | | H

C — Internal Source

D =Sy Eetartn—
# Sine Depth: |1D.D %I g G
 Trigngle -
) Bamp Fiate: |1 naooa =
= Bguare - F
= Naize Sensitivity: |1D.D ill b E

33



An Overview of AX

A. External Source Enable external AM source. If external source is enabled, all internal
related controls are gray out.

B. Sensitivity (External) Adjust the value of external sensitivity

C. Internal Source Enable internal AM source. If internal source is enabled, all external
related controls are gray out.

D. Waveform Select waveform option for internal AM. The available options are
sine, triangle, ramp, square, and noise.

E. Sensitivity (Internal) Adjust the value of internal sensitivity, and is only enabled when
waveform is set to noise.

F. Rate Adjust the value of internal Rate, and is only enabled when waveform
is set to sine, triangle, ramp or square.

G. Depth Adjust the value of internal depth, and is only enabled when wave-
form is set to sine, triangle, ramp or square.

H. AM ON/OFF Turn AM On/Off

2.4.2.2 Frequency Modulation

Double clicking on the Frequency Modulation icon will open the Frequency Modulation
window. The Frequency Modulation window allows a user to enable or disable Frequency
Modulation. In addition the user can select an External or Internal Source. For an External
Source the user can specify the Deviation and the Sensitivity. For an Internal Source the
user can specify the Deviation, the Waveform, the Sensitivity, and the Frequency.
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Navigation Window

A. External Source

B. Deviation (External)
C. Sensitivity (External)

D. Internal Source

E. Waveform

Set external deviation to Narrow or Wide.

Adjust the value of external sensitivity

Enable external FM source. If external source is enabled, all internal
related controls are gray out.

Enable internal FM source. If internal source is enabled, all external
related controls are gray out.

Select waveform option for internal FM. The available options are

sine, triangle, ramp, square, and noise.
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F. Sensitivity

G. Deviation

H. Rate

|. Deviation

J. FM ON/OFF

Adjust the value of internal sensitivity, and is only enabled when
waveform is set to noise.

Adjust the value of internal deviation, and is only enabled when
waveform is set to sine, triangle, ramp or square.

Adjust the value of internal Rate, and is only enabled when waveform
is set to sine, triangle, ramp or square..

Set internal deviation to Narrow or Wide, and is only enabled when
waveform is set to noise.

Turn FM On/Off

2.4.2.3 Pulse Modulation

Double clicking on the Pulse Modulation icon will open the Pulse Modulation window.
The Pulse Modulation window allows you to enable or disable Pulse Modulation. In addi-
tion, you can select an External or Internal Source. For an External Source, you can spec-
ify Polarity. For an Internal Source, you can specify the pulse width, sync out delay for
Triggered, Continuous, and Gated modes. For each of these modes PRI, trigger polarity,
and RF pulse can be specified depending on the mode of operation.
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A. External Source Enable external FM source. If external source is enabled, all internal

Polarity

B. Internal Source

related controls are gray out.

Set external Poliary to either Active High or Low

Enable internal PM source. If internal source is enabled, all external
related controls are gray out.
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C. PM Mode
Triggered

Continuous

Gated

D. Width

E. Syncout Delay
F. Width

G. PRI

H. RF Pulse

I. Trigger Polarity
I. PM ON/OFF

Select between Triggered, Continuous, and Gated PM mode.

Selecting this mode outputs one pulse per external trigger received
following the sync delay.

Selecting this mode outputs a continuous train of pulses specified by
the PRI and pulse width parameters.

Selecting this mode outputs a burst of pulses specified by the PRI
and pulse width parameters for the duration of the gating signal
applied to the external trigger input.

Adjust value of internal pulse width.

Adjust value of internal trigger delay.

Adjust value of internal trigger width.

Adjust value of internal trigger PRI.

Adjust the pulse delay.

Set the external trigger polarity to either Falling or Rising.

Turns PM ON/OFF.

2.4.2.4 Scan Modulation

Double clicking on the Scan Modulation icon will open the Scan Modulation window. The
Scan Modulation window will automatically create a Scan Modulation List. The user can
specify the following items for Scan Modulation setup: Power, Number of Lobes, Scan
Time, and Frequency. By clicking the Apply button a Scan Modulation List is generated,
loaded into the List Controller, and displayed graphically.
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A. Power (dBm) Set power in dBm.
B. Number of Lobes Set the number of lobes in Scan.
C. Scan Time Set the scan time.
D. Frequency (MHz) Set frequency for the Scan.
E. Scan Modulation Graph Display the waveform generated by the inputs
F. Apply Apply all the input to create a list
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G. Points per cycle Display the number of points in every cycle

H. Time per point (ms) Display the time taken for every point

I. Number of points Display the number of list points generated in graph.
J. Number of cycles Display the number of cycles in the graph.

K. Power Display power in W.

2.4.3 System Control Windows

Clicking the System icon in the navigation window will open the System menu with all of
its icons displayed. An additional click will hide the System sub-items.

2.4.3.1 Interface Window

The Interface window allows you to set the communications interface between the PC
and the 2400. You can choose between GPIB or RS-232/USB. You can choose a specific
GPIB address or com port or you can allow Automation Xpress to automatically detect
the 2400 on any of the communication interfaces. Opening the Interface window can be
performed two ways:

e Click on the System menu in the toolbar and select Interface.

® Click on the System Interface icon located on the toolbar or the System Inter-
face icon located within the Navigation window.
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A. Connection Interface

B. GPIB

Switch Address

Set Address

Lets you select the cable connection used to connect your PC with
the hardware device.

Selecting the GPIB option will set the connection through the
GPIB interface.

Lets you switch to another 2400 if it is connected to the PC
via one of the communications interfaces

Lets you change the GPIB address of the 2400 that is connected
via the GPIB interface. You must click APPLY for the
new address to be set.
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C. Serial Port

COM Port
Baud Rate

Data Bits

Parity

Stop Bits

D. Auto Connection

E. Demo Mode

F. Apply

You can select from COM 1 through 9. The COM port selection
must be a valid port with a 2400 synthesizer connected to

the port. The port connection can be an adapted USB/RS-
232 or RS-232

Lets you select the COM Port.

Lets you select the baud rate. 115200, 38400, 19200 or 9600
baud rate can be selected. 115200 is the current default setting.

Lets you select the data bits. There are two options: 8 and 7.
“8” is the current default setting.

Lets you select the data bits, which has three options: Odd,
Even and None. “None” is the current default setting.

Let’s you select the data bits, which have two options: 1 and
2. 1”7 is the current default setting.

This option automatically detects any 2400 synthesizer connected to
the PC through the GPIB and/or RS-232. This feature can be used
when the address or connection type to the 2400 is not known. This
feature will take a few moments to search all available connections.

Automation Xpress will run in the demonstration mode as if a 2400
was connected to the controller. Some features such as Auto-Pro-
gramming will not function because they require a 2400 tocomplete
the communication process.

Clicking the apply button will apply the selected cable connection
options.
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2.4.3.2 General Information Window

The General Information window provides important information about your current 2400
Microwave Synthesizer. The General Information window describes your current model,
serial information, current firmware version, and hardware specifications.

=olx|

Model Number: 2400
Serial Number: 1}
Firmware Yersion:

DLL Yersion:

Min. Frequency (MHz): 10
Max. Frequency (MHz): 20000
Mod Gen: 1}
Min. Power (dBm): -20
Max. Power (dBm): 25
Attenuator: 0
Maximum List Points: 4000
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2.4.4 Tools Control Windows

Clicking the Tools icon in the navigation window will open the Tools menu with all of its
icons displayed. An additional click will hide the Tools sub-items.

2.4.41 Auto-Programming for Visual Basic and Visual C++ Window

ol
DLL

A v Save command script befare clasing this windaw

B —-LLL Function calls

C ———Export to file Llear | Create Project | E

D
A. Save Command Script Checking this box will automatically save the command script when
the Auto-Programmer window is closed.
B. AX Function Calls Displays the current AX function calls.
C. Export to File Clicking this button exports AX function calls to a text file.
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D. Clear Clicking this button clears the AX function calls.

E. Create Project Clicking this button will open the Create Project window for use with
Microsoft Visual C++ or Visual Basic software.
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2.5 Service Tab

Clicking on the Service menu tab in the Navigation window will open the Service menu.
When the Service menu displays, the Service menu icons will appear in the Navigation

window.

The following headings below describe the window menus that display when the Service
menu tab is selected in the Navigation window, unless explicitly marked as descriptive
only. Please refer to Chapter 4 for detailed service information.

= LCD Test

@ SCPI Status Reporting

n Tools

e Firmware Dawnload

E" Control n Servicel

2.5.1 Test
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———— (" Diagonal
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Service Tab

Clicking the Test icon in the navigation window will open the Test menu with all of its
icons displayed. An additional click will hide the Test sub-items.

2.5.2 LCD Test

Double clicking the LCD Test icon will open the LCD test window. From this window you
can select and run one of the following tests: All, Horizontal, Diagonal, None, and Off.
Please refer to Chapter 4 for detailed service information.

-ioix

r— Display Screen Selection

Test Il F

A. All Turns on all pixels on the GT2400 display.
B. Horizontal Turns on pixels to form horizontal lines on the GT2400 display.

C. Diagonal Turns on pixels to form diagonal lines on the GT2400 display.
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D. None Turns off all pixels on the GT2400 display.
E. Off Turns all LCD tests off.
F. Test

2.5.3 Status Reporting Menu

Clicking the Status Reporting Menu icon in the Navigation window will open the Status
Reporting menu.

-Ioi

Stetus Fiepor Settings:

Erroni/Event Queue
[# Enable snorfevery interrupt

Meszage Available
[¥ Enable meszage intarrup:

Standard Event Status
[ Operation complets
[# Cluery errar
¥ Execution erar
[¥ Command errar
I Fower on

HQuestionable status
[# ALC unieveled
¥ Sunth unlocked
[# Mo eusternal refenancs

Restoe Defautsl
Ok |
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2.5.4 Tools

Clicking the Tools icon in the Service Menu of the Navigation window will open the Tools
menu. Opening the Tools menu will display the Tools sub-menus. An additional click will
hide the Tools sub-menus.

2.5.4.1 Firmware Download

Double clicking the Firmware Download icon will open the Firmware Download window.
This window allows you to download files via the COM port. You must select the appro-
priate COM port.

-ioix

Download File

COM Part: |1 vl
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2.6 Message Window

The Message window displays the status messages from the 2400. The Message window
is divided into a left and right side. The left side of the Message window displays the sys-
tem status messages and error messages. The right side of the Message window is
referred to as the Communication message area. The Communication message area dis-
plays the Tx/Rx messages. You can clear all messages displayed in the left message win-
dow at any time by selecting the Clear Message icon (B). To clear all messages in the
Communication message area, Click the Tx/Rx message bar.

A _& Time [ Message v Shaw Tw/Bix g [ Cpamsg | Al
B 3/24/2004 34156 Frd Itis Demo mode and no connection. Tie &5l St Cad
— Tr PO erATT eruation ODE
K Tr: AL Sat Cnd
C —10 |4 | | Te 83 Set D! -

A. Closes the Message Display window.
B. Deletes all sytem status and error messages displayed in the message window.

C. Click the Clear Message icon to clear all communication messages displayed in the
communication message area of the message window.

D. Check to Show/Hide the Tx/Rx messages displayed in the communication message are of the
message window.

E. Click the Clear msg button on the Tx/Rx Message bar to clear all messages the Communication
Message area.

2.7 Status Bar

The Status bar is used to display the current system status. Panel one of the status bar
displays the connected GPIB address or a COM port number of the serial port. The Status
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bar also displays the DEMO MODE, if there is no connection with the 2400. Panel two of
the status bar displays the language interface option such as default, SCPI, or GT12000.

2.8 Main Work Area

The main work area of the Automation Xpress software provides an area for the multiple
Automation Xpress control windows to open in.

=13l=
Fiz Ch Jow Zpndio Salon T Mele Ko

e F o ]3] 23 o)
@ Ny Comne tian @lhlkal g Tkl e g L] @l @ P @Rk
= - alol
= Upoa
CEmr e o
£ B L ok Froquercy A | Work Area
B b s o - -l
S e II..'.CCD -
B ral o .
- T3 erEE b
ZE Tek it
o Coorzec beap | Poersn Lavel @ ¥ 312000 dive rras
-+ Bk Pcia-ne - a
<o P IIL.CC B U0 Feseomdmisdegis s
1 MkaProcra-nic
[

baparkbn | _:|=|u=zx;|=|

Dznp vagc

2.8.1 Opening and closing control windows

In general, you open and close control windows the same way you do in other programs.
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By default, when you run the Automation Xpress program, it automatically opens the

CW Mode and Connection Selection window. You can open the control windows at any
time by using the Navigation window. When you double click with your mouse on an icon
in the Navigation window, the control window will automatically open in the Main work
area. You can also use the Operation drop down menu located on the Menu bar to open
any of the control windows.



AUTOMATION XPRESS INTERFACE
(AXI)

Chapter Highlights

+ Automation Xpres Interface (AXI) Overview
¢ How to use the AXI Functions
¢+ CW Operation using V++ and Visual Basic

¢ List Mode Operation using V++ and Visual Basic

This chapter introduces you to the Automation Xpress Interface and explains how to generate
code rapidly that you can integrate it into your ATE applications. The Automation Xpress Inter-
face enables you to quickly program and configure your model 2400 Series synthesizer into your
ATE application.

The following sections provide a step by step guide on the use of the GT2400 AXI with the Visual
C++ or Visual Basic programming interface.
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3.1 Automation Xpress Interface (AXI)

Automation Xpress Interface is provided in the form of a Dynamic Link Library. The fol-
lowing sections describe functions of the GT2400 AXI in details.

AXl Include Files:

GT2400.h For Visual C++

DLLDeclare.bas For Visual Basic

3.1.1 Using the GT2400 AXI

The following sections provides step-by-step instructions for integrating the AXI functions
into your ATE application. Depending on your programming environment, the following
two sections provide a guide on how to load the GT2400 AXI into your project.

3.1.2 C/C++ Program Interface

Step Description
1 Create a Visual C++ project.
2 Copy GT2400.dll from C:\Program Files\Giga-tronics\Automation Xpress\bin
into your project's executable folder for run time calls. (e.g. folder named
"Debug")
3 Copy all files from C:\Program Files\Giga-tronics\Automation Xpress\include
into your project for compilation.
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Step Description

4 Add GT2400.lib from C:\Program Files\Giga-tronics\Automation Xpress\lib into
the project for compilation.

5 Add GT2400.h from C:\Program Files\Giga-tronics\Automation Xpress\include
into the project.

6 Copy following line into your application C/C++ files
#include "GT2400.h".

7 Make DLL function calls as needed from any .cpp files where GT2400.h file is
included.

8 Build.

3.1.3 Visual Basic Program Interface

Step Description

1 Create a Visual Basic project.

2 Copy GT2400.dIl from C:\Program Files\Giga-tronics\Automation
Xpress\bin into your project's executable folder for run time calls.

3 Copy DLLDeclare.bas from C:\Program Files\Giga-tronics\Automa-
tion Xpress\VBModule to the project folder.

4 Load the DLLDeclare.bas module into your project.

5 Make DLL function calls as needed from any files in the project.
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Step

Description

6

Build.

3.1.4 CW Operation using Visual C++

The following example describes how to remotely configure the model 2400 for CW fre-
guency operation in Visual Basic. The example opens a connection via GPIB to the 2400
set to address 6. The routine sets the 2400 to 20 GHz and the power level to 10 dBm.
After the 2400 is configured, the RF output is activated and the connection is closed. For
other frequencies and power levels, the Frequency and Power parameters can be modi-
fied to meet the individual requirements.

Note: Only bold faced code lines are unique to a specific operation mode. All other lines
are supporting lines shared by both CW and List modes

Step

Description

1

Follow step 1 through step 4 of the section “3.1.2 C/C++ Program Interface”
on page 54, to create a Visual C++ project.
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Step

Description

Write following
#include "GT2400.h"
#include "stdio.h"
#define SUCCESS 0

/[This routine sets CW frequency and power of a GT2400 synthesizer
//at your choice through GPIB at address 6.
void main(void)

{

STATUS status;

unsigned long instrumentHandle;
double Frequency = 1000;
double Power = 0;

status = GT2400_OpenConnection(0, 6, 0,&instrumentHandle);
if(status < SUCCESS )

char statusText[256];
GT2400_GetErrorMessage(status, statusText);
printf("Status Message %s\n",statusText);

}

status = GT2400_SetRF(instrumentHandle, 1);

printf("Frequency (MHz) =");
scanf("%If",&Frequency);

printf("Power (dBm) =");
scanf("%If",&Power);

status = GT2400_SetCW(instrumentHandle, Frequency, Power,
0,0);

status = GT2400_CloseAllConnections();

57




Automation Xpress Interface (AXI)

58

Step Description
3 Build
4 Run

3.1.5 CW operation using Visual Basic

The following example describes how to remotely configure the model 2400 for CW fre-
guency operation in Visual Basic. The example opens a connection via GPIB to the 2400
set to address 6. The routine sets the 2400 to 20 GHz and the power level to 10 dBm.
After the 2400 is configured, the RF output is activated and the connection is closed. For
other frequencies and power levels, the Frequency and Power parameters can be modi-
fied to meet the individual requirements.

Step

Description

Follow step 1 through step 4 of section “3.1.3 Visual Basic Program Inter-
face” on page 55, to create a Visual Basic project.
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Step

Description

Write the following
‘This routine sets CW frequency and power of a GT2400 synthesizer
'via GPIB at address 6.

Dim status As Long

Dim instrumentHandle As Long
Dim Frequency As Double

Dim Power As Double

Dim statusText As String

statusText = Space(100)

status = GT2400_OpenConnection(0, 6, 0,instrumentHandle)
If status < SUCCESS Then
GT2400_GetErrorMessage(status, statusText)

MsgBox statusText

End If

status = GT2400_SetRF(instrumentHandle, 1)

Frequency = 20000 'MHz

Power =10

status = GT2400_SetCW(instrumentHandle, Frequency, Power,
0,0)

status = GT2400_CloseAllConnections()

Build.

Run.
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3.1.6 List operation using Visual C++

This example describes a step-by-step procedure for integrating the GT2400 AXI into
your Visual Basic project, loading a list file into memory, downloading the list into the
2400 and running the list. The list file is a text-based file that can be created using
Microsoft Excel, text editor or the Automation Xpress Interface. The example also pro-
vides for error checking to ensure that the data in the list file is properly structured,
loaded into the DLL memory and is successfully downloaded into the 2400. When the
program is executed, the program queries the user to input the list file, select the list
sweep operation and trigger type.

Step

Description

Follow step 1 through step 5 of the section “3.1.2 C/C++ Program Interface”
on page 54,to create a Visual C++ project.
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Step

Description

Write following:

#include <windows.h>
#include <stdio.h>
#include "gt2400.h"
#define SUCCESSO

/[This routine can load any list file to GT2400 synthesizer
/land set up repeat type and trigger type at user choice.
void main(void)

{

long status;

char listFileName[80];

char statusText[256];

unsigned long instrumentHandle;
short tmp;

status = GT2400_OpenConnection(0, 6, 0, &instrumentHandle);
if(status < SUCCESS )

{

GT2400_GetErrorMessage(status, statusText);

printf("Status Message %s\n",statusText);

}

printf("Please enter the file name to be loaded:\n ");
scanf("%s",&listFileName);

status = GT2400_LoadListFromFile(listFileName, statusText);
if ( status < SUCCESS )//Error during loading

{

GT2400_GetErrorMessage(status, statusText);

printf("Status Message %s\n",statusText);

}

status = GT2400_DownloadList(instrumentHandle, listFileName);

printf("Enter Repeat Type (0 = single step; 1 = single sweep; 2 = con-
tinuous) =");

scanf("%d",&tmp);

status = GT2400_SetRepeatType(instrumentHandle, tmp); 61

printf("Enter Trigger Type (0 = External trigger; 1 = Software trigger
or GET) =");
scanf("%d",&tmp);




Automation Xpress Interface (AXI)

62

Step Description
3 Build.
4 Run.
5 Trigger.

3.1.7 List operation using Visual Basic

This example describes a step-by-step procedure for integrating the GT2400 AXI into
your Visual Basic project, loading a list file into memory, downloading the list into the
2400 and running the list. The list file is a text-based file that can be created using
Microsoft Excel, text editor or the Automation Xpress interface. The example also pro-
vides for error checking to ensure that the data in the list file is properly structured,
loaded into the DLL memory and is successfully downloaded into the 2400. When the
program is executed, the program queries the user to input the list file, select the list
sweep operation and trigger type.

Step

Description

Follow step 1 through step 5 of section “3.1.5 CW operation using Visual
Basic” on page 58, to create a Visual Basic project.
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Step

Description

Write following:
"This routine will load any list file to GT2400 synthesizer
‘and set up repeat type and trigger type.

Dim status As Long

Dim listFileName As String
Dim statusText As String

Dim instrumentHandle As Long

statusText = Space(100)

status = GT2400_OpenConnection(0, 6, 0, instrumentHandle)
If status < SUCCESS Then
GT2400_GetErrorMessage(status, statusText)

MsgBox statusText

End If

'Please replace C:\Temp\ListTest.txt with your list file name.
listFileName = "C:\Temp\ListTest.txt"

status = GT2400_LoadListFromFile(listFileName, listFileName)
If status < SUCCESS Then

‘Error during loading

GT2400_GetErrorMessage(status, statusText)

MsgBox statusText

End If

status = GT2400_DownloadList(instrumentHandle, listFileName)

'‘Repeat Type (0 = single step; 1 = single sweep; 2 = continuous) =")
status = GT2400_SetRepeatType(instrumentHandle, 1)

' Trigger Type (0 = External trigger; 1 = Software trigger or GET) ="
status = GT2400_SetTriggerType(instrumentHandle, 0)

status = GT2400_SetRF(instrumentHandle, 1)

status = GT2400_CloseAllConnections()
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Step Description
3 Build.
4 Run.
5 Trigger.
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Chapter Highlights

+ How to use CW Mode Operations
¢ How to use List Mode Operations

¢ How to use Modulation Operations

The following chapter provides an overview of Automation Xpress basic operations. You will learn
how to configure a list using the List Editor and List Controller window. In addition, you will learn
how to run and download a list.
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4.1.1
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AX Graphical User Interface

Automation Xpress takes advantage of the familiar Windows environment, intuitive user
interface, and computer graphic capabilities. The well-designed and intuitive Automation
Xpress graphical interface frees you from learning complex commands and makes Auto-
mation Xpress easy to use. Automation Xpress ensures fast switching times and list down-
loads when using the Automation Xpress CW and List Mode feature. The GUI interface
provides you the capability of remote controlling the 2400. You can use the GUI interface
for CW mode control and List Mode control. The following sections will describe how to
use the GUI for remote operation.

Using CW Mode Operations

The CW Mode window controls the frequency and power level output of the 2400 syn-
thesizer. For models with option 26, 90 dB step attenuator, you can manually control the
step attenuator or let the 2400 automatically switch the attenuator.

4.1.1.1 Setting Parameters in the CW Mode Window

Editing frequency, power, and step attenautor control and settings are performed with
the CW Mode window.

1 Double clicking on the CW Mode icon in the Navigation window opens the CW Mode
window.

2 Using your mouse, highlight the field you would like to change. Either by positioning
your mouse on the desired digit to adjust and using the Up/Down arrows located on
the right side of the text box to increase or decrease the value. Or by directly high-

light the field you would like to change and type your number directly, then press
enter.

3 To change the step size in the text box, highlight the desired step size digit. Double-
clicking on the field will select the entire value to the decimal point. To select the
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entire number, click and drag the mouse over the entire field. The field can also be
changed using the numeric keypad on the controller keyboard. All or part of the field
can be changed depending on the section of the number that is highlighted.

Pressing enter on your keyboard, changing the frequency unit, or using the up/down keys
will send a command from your computer to the GT2400.

4.1.1.2 Setting Frequency Directly

The frequency can be adjusted by directly typing the desired frequency into the fre-
quency field.

1 Using your mouse, highlight the displayed numbers in the frequency field.

2 Once the numbers are highlighted in black, use your numeric keypad to type a desired
frequency number directly into the frequency field. Once you begin typing a desired
frequency, the frequency field will be selected (yellow).

4.1.1.3 Setting Frequency Units
The frequency field allows you to select from several frequency units.

1 Click on the pull down selection and select the appropriate unit value.

2 Using the Up/Down selection or numeric keypad, change the frequency unit setting to
the desired unit value. The new frequency setting is immediately downloaded to the
2400.

4.1.1.4 Setting Power

The power setting is always entered in dBm units.
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1 Using the Up/Down selection or numeric keypad, change the setting to the desired
value. The new power setting is immediately downloaded to the 2400.

4.1.2 Step Attenuator Control (Option 26)

The step attenuator is controlled manually or automatically. Under certain conditions, it is
desirable not to have the step attenuator automatically switch. The first switch point is at
-5 dBm. Additional switch points occur at 10 dB increments starting with -5 dBm to the
minimum setting of the 2400. The Manual Attenuation drop down box will display the
current state of the step attenuator when the Attenuation field is set to Manual Mode.

4.1.2.1 To set the Step Attenuator Mode:

1 Click on the AUTO radio button for internal control of the step attenuator.
OR

2 Click on the MANUAL radio button for manual control of the step attenuator. The Man-
ual Attentuation selection allows you to control the step attenuator setting starting at
0 dB. The attenuator can be adjusted from 0 to 90 dB, in 10 dB increments. Clicking
on a value in the Manual Attenuation pull-down selection automatically sets the step
attenuator to the newly selected setting.

Note: Manual control of the step attenuator restricts the settable range of the output. If a

level setting is out of range, the manual attenuation must be set within + or - 20 dB of the
desired setting.
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4.1.3 Using List Mode Operations

You can use Automation Xpress to control list mode operations. Automation Xpress's list
mode operation window ensures fast switching and download times.

The List Mode Operation consists of two list windows, the List Controller window and the
List Editor Window. The List Controller window is used to manage and run lists. The List
Editor window is used to create new lists, add new points to an existing list or delete one
or more points in a selected list. Once a list is loaded into the List Controller window, indi-
vidual points can be modified.

4.1.3.1 About List Operation

The GT2400 list operation is an operation that executes a series of pre-programmed

instrument states (points). The list is capable of storing more than 4000 points. Each point
in the list defines the GT2400 frequency, power, sync. output conditions for a fixed period
of time (step time), as shown in the following figure. A remote command or external TTL
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trigger can be used to initiate the list. Only one list can be stored in the 2400 at any one
time

List Point 1 List Point 2 List Point 3

RF Output

[—Step Time —b‘

Trigger
EXT, GET, SW

(€ Sync Delay— | |_| |_| Sync Delay Output
| | | LockiLevel Output

Figure 1: List Attributes

4.1.3.2 Dynamic Range and Step Attenuator Control

Automation Xpress's list mode prevents the step attenuator from switching automatically.
However, this restriction is not applied when programming the 2400 without Automation
Xpress software.. Care should be taken whenever programming power lists for 2400's
equipped with Option 26 Step Attenuator, 90 dB step attenuator installed. Operating a
power list with the step attenuator set to automatic may cause excessive attenuator
switching that can shorten the life the step attenuator. The maximum settable dynamic
range with the step attenuator set to manual is 40 dB. Power levels in the list must be
within a £20 dB range of the manual step attenuator setting. When programming a
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power list, the step attenuator should be set to manual and set to the middle of the
power list dynamic range.

4.1.3.3 Creating a List

Automation Xpress offers three distinct methods for creating lists. You can create a list by:

1 Creating a list using Automation Xpress's List Controller window.
2 Creating a list using Automation Xpress's List Editor window.

3 Importing a list you created in Microsoft Excel or a text editor program

4.1.3.4 Creating a List using the List Controller Window

The List Controller window provides access to the list parameters needed to operate the
2400 in list mode. In addition to operational control, the List Controller also maintains list
files stored in memory or on a storage media such as the controller hard drive.

The List Table box located within the List Controller window displays lists you have cre-
ated. You select a list from the List Table box to edit and to download to the 2400.

To begin creating a new list, a list name must be established first. You must have the List
Controller window open to create a new list. If you already have a list file with a valid for-
mat, skip this section and go directly to (“Running a List” on page 65). Automation Xpress
provides two methods for creating a new list.

4.1.3.5 Naming a List

1 Open the List Controller window by selecting the OPERATION MENU dropdown and
select>LIST CONTROLLER.

2 Select> FILE MENU and select >NEW LIST.
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3 The Create a List dialog box will appear. Type a new list name in the List Label field and
click>OK.

o

List Label: IList ?

(0] 4 Cancel |

OR
1 Open the List Controller window by selecting the OPERATION MENU dropdown and
select>LIST CONTROLLER.

2 In the List Controller window, place your mouse over the List Table box and right
mouse click. Select >NEW LIST from the list pop up menu.

3 The Create a List dialog box will appear. Type a new list name in the List Label field and
click>OK.

Once a new list name has been established, list point information can be added to the
newly created list. Lists can be stored in the memory allocated by Automation Xpress or
on your computers hard drive, floppy disk or any other valid storage medium.

4.1.3.6 Editing a List Point

To edit a list point in the List Controller window, move your mouse over the list point and
click on it. This will select and highlight the current list point to edit.
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The list point information will be displayed in the Current List Point field. You can make
changes to the current list point by typing directly into this field. When you are finished
editing the list point, the grayed out UPDATE button will become active and you can now
click the UPDATE button to apply the change.

New list points can be added before or after the list point in the Current List Point field by
clicking on the ADD BEFORE or ADD AFTER buttons.

To edit the selected list point:

1 Click on the UPDATE button.
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A list point can also be removed from the list by clicking on the DELETE button. Any time
the list has been modified; it must be downloaded into the 2400. Once a list has been
downloaded, the DOWNLOAD button will be disabled. Any change in the list editor win-
dow, triggering method, step attenuator state or delay setting will enable the DOWN-
LOAD button, indicating that a change has been made and the list must be downloaded
into the 2400.

After a list is configured and editing is complete, the list must be downloaded from the
Automation Xpress program to the 2400 memory.

4.1.3.7 Creating a List in the List Controller Window Tutorial

The following example describes the creation of a simple list using the List Controller
Window. The list will consist of 3 points with frequencies at 2, 8, 12 GHz. The power set-
ting is 10 dBm for all points in the list. The first list point will also output a sync. signal.
With the mouse over the List Table box, right click and select NEW LIST.

Type LIST 2 in the List Label of the Create a List input box and click OK.

Double click on the Frequency box in the Current List Point field and enter 2000
Double click on the Power box in the Current List Point field and enter 10.

Click on Add After to add the first list point to the new list. Add Before can also be
used

a p 0N =

6 Repeat step 3 and enter 8000.

7 Click on ADD AFTER to add the new point. Note that the power setting does not
change from the last entered list point.

The power setting does not change from the previous list point. The List controller main-
tains all information from the previous list point to reduce list point data entry.

1 Click on the BNC Sync Out checkbox to disable the sync. signal for this point

2 Repeat step 3 and enter 12000. Click on Add After to add the new point
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4.1.3.8 Creating a List Using the List Editor Window

The List Editor window is used to create new lists, add new points to an existing list or
delete one or more points in a selected list. The List Editor window provides a useful way
to edit a range or add points to your current running list by step frequency or step power.
You can edit or add a list point(s) to your current running list by specifying the start, stop,
step, dwell time, and power level.

The List Editor is used to quickly create simple lists where frequency and power is incre-
mented or decremented in fixed steps. The list step is set using either a fixed step value
or calculated by taking the difference between the start and stop points and then divid-
ing the range by the number of requested points. The List Editor is used in conjunction

with the List Controller, and permits new points to be added to or replace the list in the
active list window.

4.1.3.8.1 Configuring a frequency or level list range

Configuring a frequency or level list range in the List Editor window requires three basic
parameters: start parameter, stop parameter, and the frequency or level setting of all
points in the new list range.

Choose the list range type you wish to create by selecting between the BY FREQUENCY
or BY POWER (dBm) option.

Type the value of the start parameter into the START PARAMETER field and select the
appropriate unit. If you have selected to create a list with power as a parameter, all units
displayed are measured in dBm.

Type the value of the stop parameter into the STOP PARAMETER field.
Enter the power level of the list range.

The list step time can be set from within the List Editor window or the List Controller win-
dow at the time of the list download to the 2400.
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4.1.3.8.2 Setting the list step size

You can set the list step size by directly entering a value into the Step Parameter field.
The total number of points will be determined by the size of the step. The list size can
also be set to a fixed number of points. The Increment Option field provides you with a
choice of either method to set the list step size.

From the INCREMENT OPTION field> click on the STEP option radio button. Selecting
the STEP option will activate the STEP PARAMETER field of the List Range. When the
STEP option is selected, the list will include the start and stop values plus the maximum
allowable frequencies determined by the step size. The spacing between sequential list
points will be equal with the exception of the last two list points if difference between the
start and stop parameter is not evenly divided by the step parameter.

From the INCREMENT OPTION field> click on the # OF POINTS option. Selecting the #
OF POINTS option will activate the NUMBER OF LIST POINTS field. The list is created
with a fixed number of points specified in the Number of Points field. The size of the step
is determined by difference of the start and stop parameter divided by the number of
points. The spacing between sequential list points will be equal.

4.1.3.8.3 Setting the Replacement Type

An existing list can replace or be inserted into the active list. The Replacement field pro-
vides you with the option to replace the entire list or insert the new list information before
or after a selected list point in the active list. When you want to insert a new list point(s)
into the active list, select the desired list point in the active list window of the List Control-
ler by clicking on the list point.

1 Click REPLACE ALL to replace all list points with the new list information.

2 Click INSERT BEFORE to insert the new list point(s) before the selected list point in the
active list window of the List Controller.

3 Click INSERT AFTER to insert the new list point(s) after the selected list point in the
active list window of the List Controller.
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4.1.3.9 Creating a List Example

The following is a short example for creating a list using the List Editor window. The list
will switch frequency starting at 2.0 GHz and stopping at 8 GHz. The frequency step size
is 100 MHz, power level is set to +5 dBm and the step time is set to 1 msec.

Create a new list name by either selecting the file menu or right mouse click with the
mouse in the List Table window of the List Controller window.

Click on the BY FREQUENCY selection.
Click on the REPLACE ALL selection.
Click on the STEP selection

Enter the following information:

Entry Field Value
Start 2.0
Stop 8.0
Step 100
Power (dBm) 5.0

The Units selections should be set to factory defaults. If not, use the GHz units for the
start and stop fields. Use the MHz units for the step field.

1 Enter 1.0 into the STEP TIME field.

2 Click on the APPLY button
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Automation Xpress list files are text-based files that conform to a very simple format. This
enables you to generate list files using a text editor or spreadsheet software. All that is
required is that the program must be capable of saving to a text file (.txt).

Complex lists can be created using any spreadsheet program, such as Microsoft Excel or
a text editor program. The only limitation is that the program must be capable of saving
the file to a text based (.txt) format. The file format must use a space, comma, or tab
delimiter. The first row specifies the list step time and the sync. pulse delay time. The fol-
lowing rows correspond to the list points in the list. List point one starts at row two of the
text file. Each row defines the sync. pulse state, the frequency and level.

Step time and sync. pulse delay are in milliseconds.
Sync. pulse stateisa 1 or 0. 1 is enabled, 0 is disabled.

Frequency is in MHz. Power is in dBm.

4.1.4.1 List File Format

A list file must be constructed to a format that Automation Xpress will recognize. If a list
file is improperly structured, the list will not load into Automation Xpress. The file format
is simple. The first line in the list file specifies the list step time, the sync pulse delay time
and the RF Off time. The following rows correspond to the list points in the list. The first
list point begins on row two of the text file. Each row defines the Sync Signal state, fre-
quency and level settings. The parameters in the text file are separated with a comma,
space, semi-colon or tab. A line feed (Enter key) is used to terminate each row in the list
file. The following describes the list parameters in the text file.

<Step time> <Sync Delay> <RF Off Time>
<Sync State> <Frequency> <Level>

Units are not included in the list file. The following table identifies the parameter unit type
and range.
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Parameter Units Range

Step Time milliseconds 0.15- 1000

Sync Delay milliseconds 0, 0.1 - 1000

RF OFF Time milliseconds 0.1-1000

Sync State 1or0 1or0

Frequency MHz 10 to max frequency
Level dBm 10 to max level

4.1.4.1.1 Text file example:

The list file consists of three points. The list point step time is 10 msec., sync delay is 4

msec. and the RF Off time is 1 msec. Each list point will output a sync signal and all points
will be set to a level of 10 dBm. List point 1, 2, and 3 will have frequency settings of 2, 8,
16 GHz respectively. A tab delimiter, shown as <tab>, is used to separate list parameters.
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The text file can be imported by using FILE MENU and selecting the OPEN FILE. If the file
is correctly structured, the list will be loade and a message will indicate that the list suc-
cessfully loaded. The text file must be closed before it can be loaded into Automation

Xpress.

4.1.5 Loading, Saving, and Closing Lists

4.1.5.1 Loading a saved list

To load a previously saved list into the List Controller, perform either of the first two meth-
ods to create a list and select OPEN LIST from the FILE MENU or by right clicking with
your mouse in the List Table box. An explorer window will appear allowing you to select a
list from any available file path in the controller.
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4.1.6 Running a List
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There are additional parameters that define how a list is triggered and how it will execute
when a trigger is received. These parameters are set to factory default settings and can
be modified to meet a wide range of applications requiring list operation. The list param-
eters are:

4.1.6.1 Setting the Trigger Type

Trigger type defines the source of the trigger that will execute the list

External- This selection sets the list trigger to the external Trigger Input on the rear panel
of the 2400.

GPIB- This selection sets the list trigger to GPIB. The IEEE 488.2 command *TRG is sent
to the 2400 via GPIB to trigger a list.

Group Execution- This selection sets the 2400 to execute a list when a Group Executable
Trigger is received via the GPIB.

4.1.6.2 Setting the Repeat Type

Repeat type defines how the list will sweep. Select one of the following:

Single Step- This mode will switch one list point for every trigger received

Single Sweep- This mode will execute the entire list when a single trigger is received.

Continuous - This mode will execute the list and repeat until the list operation is aborted
when a single trigger is received.

4.1.6.3 Setting the Sweep Direction
Sweep direction defines the direction of the list sweep.

Forward- This setting causes the list to execute starting with the first point in the list and
progress to the last point in the list.
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Reverse - This setting causes the list to execute starting with the last point in the list and
progress to the first point in the list.

4.1.6.4 Downloading a List

Once a list has been loaded into Automation Xpress and all the necessary parameters
have been edited, the list must be downloaded from the PC to the 2400.

1 Click DOWNLOAD LIST.

Once a list has been downloaded, the Download List button will disable. Any parameter
change in the current list or new list selection will require the new or modified list to be
downloaded again.

The Automation Xpress download operation uses a binary format to program the current
list in Automation Xpress to the 2400. Large lists will take several moments to download
and compile. Using Automation Xpress's download provides a significant improvement

4.1.6.5 Triggering a List

After a list has been successfully downloaded, the 2400 is ready for the list to be trig-
gered. If either the GPIB or Group Execution is selected in the Trigger Type field, the Trig-
ger button with enable after a successful list download has occurred.

1 Click the TRIGGER button to initiate the list.

4.1.6.6 Step and Sync. Delay Time

Step time is a setting that determines the time for each list point. It is a single setting and
applies to all points in the list. The step time setting includes the list point switching time
and the dwell time at the point. List point switch time can vary according to the type of
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transition defined by the list point, however the list point switch time is no more than 400
usec. The settable range is 0.15 to 1000 msec.

4.1.6.7 Setting the step time and Delay Time

1 Enter the list step time in msec. and click the adjacent APPLY button.The Sync Out sig-
nal is a TTL signal that can be used to synchronize the list output with a measuring sys-
tem such as a power meter or receiver. The Sync Out Delay is a setting that enables
you to adjust the Sync Out signal with respect to a list point output. The sync. pulse
occurs after the list point is executed at the specified delay setting. This is especially
useful for measuring systems that use a Moving Average method in a measurement
system. The Sync Out Delay has a range of 0.05 msec to 16 msec and must always be
smaller than the List Step Time setting.

2 Enter the Sync Out Delay time in msec. and click the adjacent APPLY button.

4.1.6.8 List Operation Example

The following steps describe a typical list operation. A valid list file named Example1.txt
is loaded into Automation Xpress Memory. Repeat Type and Trigger Type and Sweep
Direction are selected and the list is downloaded to the 2400. The 2400 output is acti-
vated and the list is triggered to single sweep in the reverse direction via the List Control-
ler window.

From the List Controller window, move the mouse over the List Table field, right mouse
click and select OPEN LIST.

1 Select Example 1.txt and click OPEN.

2 Click on SINGLE SWEEP in the Repeat Type field

3 Click on GPIB in the Trigger Type field

4 Click on the drop down arrow of the SWEEP DIRECTION and select REVERSE.

5 Click on DOWNLOAD LIST.

6 Click on RF ON/OFF to activate the RF output
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7 Click on TRIGGER.

Storing a List

A list can be stored by selecting the SAVE LIST or SAVE LIST AS selections from the FILE
MENU, or by right clicking with your mouse in the List Table located in the List Controller
window. When a list is saved, the list name will be updated to include the file path where
the list was saved.

Closing a List

Lists stored in the List Table window are maintained in the controller memory allocated by
Automation Xpress. The total number of lists allowed in this window is limited by the
amount of memory available on your computer. Closing one or all lists in the List Table
window will remove the lists from memory only. It will not delete a list stored on the hard
drive.

Note: Closing a list will not automatically save the list to the hard drive nor will you be
asked to save the list before closing.

Using Modulation

4.1.9.1 Using Amplitude Modulation

The Amplitude Modulation window is available when Automation Xpress software is con-
nected to a 2400M series synthesizer or in Demo mode only. Control is provided for
external AM settings and internal AM settings when option 24, Internal Function Genera-
tor is installed in the 2400M.
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1 Double click on the Modulation Icon in the Navigation window to access the Ampli-
tude Modulation window. Double click on the AM icon to activate the Amplitude
Modulation window.

2 For External Modulation, click on the External Source option to select the External con-
trol. Use the mouse to set the sensitivity by clicking on the up or down step functions.
Highlighting any digit with the mouse sets the step size. The sensitivity can also be
edited by highlighting any part or all of the sensitivity setting, enter the value directly
and press the Enter key on your keyboard.

3 For Internal Source Modulation, click on the Internal Source option to select Internal
control. Click on the desired waveform option. You can choose Sine, Triangle, Ramp
Square, or Noise. Set the internal source rate and AM depth. Selecting Noise will acti-
vate the Noise sensitivity control. The Noise selection allows you to control the depth
of AM only. There is no rate control for this setting.

4 Click on the AM On/Off button to toggle the AM modulation state of the 2400M.

4.1.9.2 Using Frequency Modulation Operation

The Frequency Modulation window is available when Automation Xpress software is con-
nected to a 2400M series synthesizer or in Demo mode only. Control is provided for
external FM settings and internal FM settings when option 24, Internal Function Genera-
tor is installed in the 2400M.

1 Double click on the Modulation Icon in the Navigation window to access the Fre-
quency Modulation window. Double click on the FM icon to activate the Frequency
Modulation window.

2 For External Modulation, click on the External Source option to select the External con-
trol. Select the FM Mode for Narrow or Wide FM operation. Use the mouse to set the
sensitivity by clicking on the up or down step functions. Highlighting any digit with the
mouse sets the step size. The sensitivity can also be edited by highlighting any part or
all of the sensitivity setting, enter the value directly and press the Enter key on your
keyboard.
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3 For Internal Source Modulation, click on the Internal Source option to select Internal
control. Click on the desired waveform option. Using the mouse and/or keyboard, edit
the Deviation and Rate parameters. The Wide and Narrow mode selection is not avail-
able because the 2400M automatically adjusts the mode for best performance based
on Rate and Deviation settings.

4 Click on the FM On/Off button to toggle the FM modulation state of the 2400M.

4.1.9.3 Using Pulse Modulation Operations

The Pulse Modulation window is available when Automation Xpress software is con-
nected to a 2400M series synthesizer or in Demo mode only. Control is provided for
external Pulse settings and internal Pulse settings when option 24, Internal Function Gen-
erator is installed in the 2400M.

1 Double click on the Modulation Icon in the Navigation window to access the Pulse
Modulation window. Double click on the Pulse Modulation icon to activate the Pulse
Modulation window.

2 Click on the PM On/Off button to toggle the pulse modulation state On or Off.

3 For External Modulation, click on the External Source option to select the External con-
trol. Use the mouse to select the input trigger polarity. Pulse width and period is
determined by the external drive signal supplied to the 2400M.

4 For Internal Modulation, click on the Internal Source option to enable the Internal
Source menu.

5 Pulse width and sync out delay are edited using the mouse and/or keyboard. The pulse
width and sync out delay entry fields are located at the bottom of the Internal Source
Window.

6 Continuous operation allows you to adjust the period of the pulsed RF output. Note:
The period must be greater than the pulse width setting. Automation Xpress will auto-
matically reset the pulse width to be lower than the period in cases where the period
entered is less than the pulse width.
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7 Triggered operation allows you to generate an RF pulse with a controllable pulse width
and delay setting. The RF pulse is output after an external trigger is received and the
delay time has been reached.

8 Gated operation allows you to generate a multiple pulse burst controlled by an exter-
nal gate. This function allows you to control the pulse width, sync pulse delay, pulse
repetition interval and trigger polarity of the pulse. The 2400M will output a pulse
train for the duration of the gating signal. If the gate signal is terminated after a pulse
has been initiated, the 2400M will complete the pulse burst specified by the pulse
width.

4.1.9.4 Using Scan Modulation Operations

The Scan Modulation window is available when Automation Xpress software is connected
to a 2400M series synthesizer or in Demo mode only. Scan modulation uses list mode to
generate a SinX/X waveform.

1 Double click on the Modulation Icon in the Navigation window to access the Scan
Modulation window. Double click on the Scan Modulation icon to activate the Scan
Modulation window.

2 Enter the power level of the scan waveform in the Power field. This power setting is the
highest level in the scan waveform.

3 Enter the number of lobes of the SinX/X waveform. The number of lobes must be an
odd integer from 1 to 49.

4 Enter the scan time in milliseconds. The scan time is the total sweep time of the SinX/X
waveform.

5 Enter the frequency of the scan waveform in MHz.

6 Click Apply to create a list that will generate the SinX/X waveform. If the List Controller
window is not already opened, or if the list window is open and no list file is active in
the list window, the list file creation window request you to enter a list file name. If a
list is already active in the List Controller window, this action will automatically replace
the current list in the List Controller. Automation Xpress
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AUTO-PROGRAMMING

Chapter Highlights
¢+ Traditional ATE Application Development

¢ Principles of Automation Xpress’s Auto-Programming

¢ Using Automation Xpress's Auto-Programming Feature

This chapter provides you with detailed information on Automation Xpress's Auto-Pro-
gramming capability.

89



Auto-Programming

5.1

5.2

90

Traditional ATE Application Development

5.1.1 Programming Using AXI Functions

The Automation Xpress Interface (AXI) simplifies programmers’ challenge, by grouping
certain commands together to achieve specific operations. Programming using the AX
functions takes advantage of the advanced internal protocols, ensuring an increase in
performance. Using the SCPI command set instead of the AX functions limits the 2400
performance by drastically reducing CW and level switching speed and list download
speeds.

Prinicipal of Auto-Programming

Automation Xpress's Auto-Programmer, a software feature embedded in the Automation
Xpress Graphical User Interface (GUI), automatically programs ATE applications for ATE
engineers. The Auto-Programmer is used in conjunction with your programming environ-
ment.

With a click of the mouse, AX’s Auto-Programming feature automatically records your
manual operations and the sequence of your actions, as well as provides you with the
option of seamlessly converting the recorded action sequence into a generated program
that you can import into to the program environment of your choice, such as Visual C++,
Microsoft Visual Basic, National Instruments LabWindows or any ANSI C based program-
ming interface. Automation Xpress's automatically generated program generates the
same results as the action sequence created manually.

The Auto-Programming for the AXI requires that you purchase the Automation Xpress
Interface, Option 48.



Using the Auto-Programmer

5.3

5.2.1 Auto-program using the AXI functions

The ATE programmer does not have to read detailed definitions of the AXI functions. The
Auto-Programmer in Automation Xpress writes the application guided by the ATE pro-
grammer using the Graphical User Inteface (GUI).

Using the Auto-Programmer

When you open the Auto-Programmer window and perform operations in the Automa-
tion Xpress Graphical User Interface, the Auto-Programmer records these operations. The
Auto-Programmer enables you to export the generated code or create projects you can
run directly from your programming environment..

5.3.1 Function Call Code Generation

The Auto-Programmer can be used to produce a fully developed project in Visual C++,
Visual Basic or generate a text file of function calls made by the Automation Xpress GUI
when the Auto-Programmer window is active in the Automation Xpress workspace. Click-
ing on the AutoProgrammer for VC++ or AutoProgrammer for VBasic icon in the Naviga-
tion Menu activates the Auto-Programmer.

5.3.1.1 Generate a text file of function calls

The Auto-Programmer window displays the function calls made by the AX GUI and does
not display the associated Visual C++ or Visual Basic coding.

91



Auto-Programming

92

Using the Export button creates a text file of the function calls captured when the Auto-
Programmer is activated. After the text file has been created, you can cut and paste the
function calls into your Visual C++ or Visual Basic project. However, it will be necessary to
create additional text around the function calls to be compatible with your project envi-
ronment. For example, setting the attenuation state causes the following function call to
be created in the text file:

GT2400_SetAttenuation(instrumentHandle, 0)

This text would not be compatible in a C or Visual Basic program environment. Editing
the text to the following syntax would be acceptable in the either program environment
with exception to the semi-colon at the end of the command string. Visual Basic does not
allow a semi-colon.

status = GT2400_SetAttenuation(instrumentHandle, 0);

The following sequence demonstrates the Auto-Programmer for generating AX function
calls to a text file. This sequence is identical for file creation to support Visual C++ or
Visual Basic. The sequence sets up an arbitrary list that steps one list point at a time for
each external trigger received by the 2400.

Step Description
1 Turn on Auto-Programmer.
2 Load a previously created list from the hard disk to Automation Xpress.
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Set repeat type to single step

Set trigger type to External

Click the download button

Export the code lines to a file by clicking the Export to a file button.

N| oo M| ®

The exported file is ready to be integrated into a project.

5.3.1.2 Generate a project in Visual C++ or Visual Basic

The Auto-Programmer can automatically generate a complete Visual C++ or Visual Basic
project including all the necessary function calls made by the AX GUI after the Auto-Pro-
grammer has been activated. It is a true one-button push operation that results in an
error-free project that you can immediately compile and run. Definitions for the files and
variables created in the project are automatically defined in the files. The following
sequence describes project creation in Visual C++ and Visual Basic. The sequence acti-
vates the Auto-Programmer (the choice of program environments is user dependent),
loads a previously created list stored in a text file, sets the trigger and repeat type and
downloads the list information to the 2400. Following the download, the project is cre-
ated.
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Step Description

1 Turn on the Auto-Programmer.

Note: Opening the Auto-Programmer window (Menu>Tools> AutoProgram-
mer) turns on the Auto-Programmer. Operations on the Automation Xpress
GUI will be recorded from this point on.

Load a previously created list from the hard disk to Automation Xpress

Set repeat type to single step

Set trigger type to External

Click download button

OO || |l W|DN

Click "Create Project" button and select project directory. Enter the name
for the new project folder and click ‘Apply’.

~

Build

8 Ready to Run
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AXI FUNCTIONS

Chapter Highlights
¢ Function Summary
¢ Connectivity Functions
¢ General Synthesizer Operation Functions
¢ CW Control, List Control and Editing Functions

¢ Modulation Control Functions

The following chapter provides a function call summary and detailed information on Automation
Xpress Interface programming functions that you can integrate into your ATE application. The
chapter divides the individual programming functions into logical groupings that pertain to over-
all instrument control functions. The AXI functions are grouped by connectivity, general sythesizer
operation, CW control, list control, and editing.
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Function Summary

Instrument Connectivity Functions

Function Call

Description Summary Section

GT2400_FindInstruments

GT2400_OpenConnection

GT2400_CloseAllConnections
GT2400_SetGPIBAddress

Find all instruments connected to the GPIB or RS- 6.2.1.1
232/USB

Open a connection from the PC to the instruments 6.2.1.2
at the specified connection

Close DLL connections 6.2.1.3

Set the 2400 GPIB address 6.2.1.4

General Synthesizer Functions

Function Call Description Summary Section
GT2400_Resetinstrument Reset the instrument to factory defaults. 6.2.2.1
GT2400_GetRF Query the instrument RF output state 6.2.2.2
GT2400_SetRF Set the instrument RF output state 6.2.2.3

GT2400_GetAttenuation

GT2400_SetAttenuation

Query the instrument Attenuation state (Option  6.2.2.4
26)

Set the instrument Attenatution state (Option 26). 6.2.2.5




6.1.3

6.1.4

Function Summary

GT2400_GetErrorMessage Query the function error status. 6.2.2.6

GT2400_GetDLLVersion Get the DLL version number. 6.2.2.7

CW Operation Functions

Function Call Description Summary Section

GT2400_GetCW Query the instrument frequency and power set- 6.2.3.1
ting.

GT2400_GetCWDataLimit Query the instrument frequency and power limits. 6.2.3.2

GT2400_SetCW Set the instrument frequency and power setting. 6.2.3.3

List Control Functions

Function Call Description Summary Section
GT2400_DownloadList Down load a list to the 2400. 6.2.4.3
GT2400_SetRepeatType Set the list repeat type. 6.2.4.4
GT2400_SetTriggerType Set the source of the list sweep trigger. 6.2.4.5
GT2400_SetListScanDirection  Set the run direction. 6.2.4.6
GT2400_SoftwareTrigger Trigger a list via remote control 6.2.4.7
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GT2400_GroupExecutionTrigger Send a Group Execution trigger 6.2.4.8
GT2400_GetListDataLimit Query the instrument maximum and minimum list 6.2.4.9
parameters.

6.1.5 List Editing Functions

Function Call Description Summary Section
GT2400_LoadListFromFile Load a list file into PC RAM for editing 6.2.5.1
GT2400_CreateNewList Create a listin PC RAM 6.2.5.2
GT2400_SavelListToFile Save the list in RAM to a file 6.2.5.3
GT2400_ActivateAList Prepare the list in the instrument for operation 6.2.5.4
GT2400_GetListData Query the active list parameters in RAM 6.2.5.5
GT2400_EditAListPoint Edit a list point of a list stored in RAM 6.2.5.6
GT2400_EditListPoints Edit multiple list points of a list stored in RAM 6.2.5.7
GT2400_EditFreqRangeByStep Edit a list using frequency range method 6.2.5.8
Freq

GT2400_EditPowerRangeBySte Edit a list using power range method 6.2.5.9
pPower

GT2400_EditFreqRangeByNum Creates a new list or modifies an existing list witha 6.2.5.10
OfPts frequency based list array specified by a number of
points

GT2400_EditPowerRangeByNu Creates a new list or modifies an existing list witha 6.2.5.11
mOfPts power based list array specified by a number of
points
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GT2400_EditRFOffTime Set the list point off-time of the active list in RAM 6.2.5.12
GT2400_EditStepTime Set the list point step-time of the active listin RAM  6.2.5.13
GT2400_EditSyncOutDelay Set the list point Sync. signal delay 6.2.5.14
GT2400_CloseAllLists Closes all lists currently stored in RAM 6.2.5.15
GT2400_CloseAList Closes a single list stored in RAM 6.2.5.16

GT2400_DeleteAllListPoints Deletes all points in the active list stored in RAM 6.2.5.17

GT2400_DeleteAListPoint Deletes a list point in the active list stored in RAM  6.2.5.18

6.1.6 Modulation Functions

Function Call Description Summary Section
GT2400_SetAMState Set the amplitude modulation state. 6.3.0.1
GT2400_SetAMSource Set the source of the amplitude modulation. 6.3.0.2
GT2400_SetAMEXxtSensititvity Set external amplitude modulation sensitivity. 6.3.0.3

GT2400_SetAMIntWavefrm Set the internal modulation generator waveform. 6.3.0.4

GT2400_SetAMIntRate Set the rate of the internal modulation generator. 6.3.0.5
GT2400_SetAMIntDepth Set the depth of the internal amplitude modulation 6.3.0.6
GT2400_SetFMState Set the frequency modulation state. 6.4.0.1
GT2400_SetFMSource Set the source of the frequency modulation. 6.4.0.2
GT2400_SetFMExtMode Set the external frequency modulation mode. 6.4.0.3
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GT2400_SetFMExtSensitivity
GT2400_SetFMIntWavefrm
GT2400_SetFMIntDev

GT2400_SetFMIntRate
GT2400_SetPMState
GT2400_SetPMSource
GT2400_SetPMEXxtPolarity
GT2400_SetPMIntTrigSource
GT2400_SetPMintTrigPolarity

GT2400_SetPMIntWidth
GT2400_SetPMintDelay
GT2400_SetPMIntPRI

Set the external frequency modulation sensitivity.
Set the internal modulation generator waveform.

Set the deviation of the internal frequency modula-
tion.

Set internal FM generator rate

Set the pulse modulation state.

Set the source of the pulse modulation.
Set the PM external input polarity.

Set the trigger source for internal PM.

Set the trigger polarity of the internal PM trigger
source.

Set the internal PM pulse width.
Set the delay for internal pulse modulation.

Set the internal pulse repetition interval

6.4.0.4
6.4.0.5
6.4.0.6

6.4.0.7
6.5.0.1
6.5.0.2
6.5.0.3
6.5.0.4
6.5.0.5

6.5.0.6
6.5.0.7
6.5.0.8




6.2

6.2.1

AXI Function Definitions

AXI Function Definitions

The functions are documented by heading, purpose, and syntax. Following the heading
for each command function is a description of the purpose of the function and a syntax
statement illustrating the proper syntax for the function. Parameters for each function are
enclosed in parathensis( ) and are defined for C programming environment.

Instrument Connectivity Functions

This group of functions is used to establish a link between the controller and one or more
2400 synthesizers via the GT2400 AXI. A connection can be established using either the
RS-232/USB or GPIB interface. Each of these functions does not require other function
calls to complete an operation but some functions can be used together to simplify con-
nectivity. A typical connection process determines the instruments connected to the I/0O,
communication sessions are established with the instruments, identification queries
determine instrument I/O assignments and the communication sessions are closed. The
Connectivity functions simplify this task.

6.2.1.1 GT_2400FindIinstruments

Purpose

Syntax

Find the addresses of instruments, either through GPIB or RS232, connected to PC.

STATUS GT2400_FindInstruments(const short connectionType
short addresses]],
short *pCount)
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Parameter

Description

connectionType

Input: Connection type. 0 = GPIB, 1 = RS232

addresses Output: Array of GPIB addresses or COM port numbers of
all the Giga-tronics instruments connected.
(Note: In case of RS232 connection interface is selected,
the first element returned in this array is the first serial port
that is connected to a Giga-tronics instrument followed by
the remaining serial port numbers on the PC.)
Example 1:
There are total of 4 COM ports on a PC, and only COM
port 1 is connected to a Giga-tronics instrument, the
returned result will be
addresses[0] = 1
addresses[1] =2
addresses[2] = 3
addresses[3] = 4
Example 2:
There are total of 4 COM ports on a PC, and only COM
port 3 is connected to a Giga-tronics instrument, the
returned result will be
addresses[0] = 3
addresses[1] =4

pCount Output: Total number of instruments connected to PC thru

the specified interface
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6.2.1.2 GT2400_OpenConnection

Purpose

Establish the communication between the PC and instrument with the specified connec-
tion interface and address.

Syntax

STATUS GT2400_OpenConnection(const short connectionType,
const short address,
const short resetDevice
unsigned long *instrumentHandle)

Parameter Description
connectionType Input: Connection interface. 0 = GPIB, 1 = RS232
Address Input: GPIB address number if ConnectionType = 0 or COM

port number if ConnectionType = 1.

resetDevice Input: 1 = Reset instrument in start up,
0 = No reset

instrumentHandle Output: The unique identification of the connected instru-
ment. This handle can be used later to operate on multiple
instruments in turn.
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6.2.1.3 GT2400 CloseAllConnections

Purpose

Close all connection. You should always call this function before you close your applica-
tion to avoid memory leak.

Syntax
STATUS GT2400_CloseAllConnections(void)

6.2.1.4 GT2400 SetGPIBAddress

Purpose

Set GPIB address.
Syntax
STATUS GT2400_SetGPIBAddress( const unsigned long instrumentHandle,

const short address,
unsigned long *updatedinstrumentHandle)

Parameter Description

instrumentHandle Input: The unique identification of the instrument

address Input: GPIB address

updatedinstrumentHandle Output: Updated instrument handle after this function com-
pletes.
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6.2.2 General Synthesizer Operation Functions
These functions provide support for general synthesizer operations. Additionally, function

support for GT2400 DLL services for the DLL version and error messages are also
included.

6.2.2.1 GT2400_Resetinstrument

Purpose

Reset the instrument to factory defaults.

Syntax

STATUS GT2400_Resetinstrument(const unsigned long instrumentHandle)

Parameter Description

instrumentHandle Input: The unique identification of the instrument.

6.2.2.2 GT2400_GetRF

Purpose

Get state of RF output.
Syntax

STATUS GT2400_GetRF(const unsigned long instrumentHandle,
short *RFState)
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Parameter Description
instrumentHandle Input: The unique identification of the instrument.
RFState Output: 1= RF is on, 0 = RF is off.

6.2.2.3 GT2400_SetRF

Purpose
Set RF on or off.

Syntax

STATUS GT2400_SetRF(const unsigned long instrumentHandle,
const short RFState)

Parameter Description
instrumentHandle Input: The unique identification of the instrument.
RFState Input: 1= Turn on, 0 = Turn off RF output

6.2.2.4 GT2400 GetAttenuation

Purpose

Get attenuation value.

Syntax

STATUS GT2400_GetAttenuation(const unsigned long instrumentHandle,
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short *pAttenuation)

Parameter Description
instrumentHandle Input: The unique identification of the instrument.
pAttenuation Output: current step attenuator setting. The range is 0 to 90

for manual attenuator control. For auto-attenuation, the
returned value is -10. If no attenuator is installed the
returned value is -99

6.2.2.5 GT2400 SetAttenuation

Purpose

Set attenuation.

Syntax

STATUS GT2400_SetAttenuation(const unsigned long instrumentHandle,
const short attenuation)

Parameter Description
instrumentHandle Input: The unique identification of the instrument.
attenuation Input: attenuation value, e.qg. if attenuation = -10,

set to auto attenuation;

else if attenuation >= 0, set to manual
attenuation with value = attenuation
attenuation = [0, 10,20,30,40,50,60,70,80,90]
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6.2.2.6 GT2400_GetErrorMessage

Purpose

Returns a text description of the STATUS value returned by any AX API function.

Syntax

STATUS GT2400_GetErrorMessage(const long statuslID, char statusText[])

Parameter Description
errorlD STATUS of any DLL function
statusText Text description of the STATUS

6.2.2.7 GT2400_GetDLLVersion

Purpose

Return DLL version.

Syntax

STATUS GT2400_GetDLLVersion(char version[])

Parameter

Description

version

DLL version
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6.2.3 CW Control Functions

The function group provides control of the CW frequency settings for the 2400 series syn-
thesizers. It also provides support for instrument queries for the current CW frequency
setting and the frequency limits for the 2400. Frequency switching speeds of less than 3
milliseconds can be obtained using the GT2400 AXI.

6.2.3.1 GT2400_GetCW

Purpose
Read current CW setting (data) from the instrument.
Syntax

STATUS GT2400_GetCWData(const unsigned long instrumentHandle,
double *frequency,
double *power)

Parameter Description

instrumentHandle Input: The unique identification of the instrument
frequency Output: CW frequency (in MHz)

power Output: CW power (in dBm)
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6.2.3.2 GT2400_GetCWDatalLimit

Purpose

Get CW data limits of the instrument.
Syntax

STATUS GT2400_GetCWDataLimit(const unsigned long instrumentHandle ,
double *pMinFreq,
double *pMaxFreq,
double *pMinPower,
double *pMaxPower)

Parameter Description

instrumentHandle Input: The unique identification of the instrument.
pMinFreq Output: Minimum frequency allowed (in MHz)
pMaxFreq Output: Maximum frequency allowed (in MHz)
pMinPower Output: Minimum power allowed (in dBm)
pMaxPower Output: Maximum power allowed (in dBm)
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6.2.3.3 GT2400_SetCW

Purpose

Set CW.
Syntax

STATUS GT2400_SetCW(const unsigned long instrumentHandle ,
double frequency,
double power)

Parameter Description
instrumentHandle Input: The unique identification of the instrument.
frequency Input: CW frequency (in MHz)
power Input: CW power (in dBm)
Example

//This example sets two CW frequencies in sequence, separated by a 40 second delay.

#include "GT2400.h"
#include "stdio.h"

#include "winbase.h"

void main(void)

{
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long STATUS;

unsigned long instrumentHandle;

printf("f= 23.456789 MHz, Power = 5 dBm\n");

STATUS = GT2400_OpenConnection(0, 6, 0,&instrumentHandle);
STATUS = GT2400_SetRF(instrumentHandle, 1);

STATUS = GT2400_SetCW(instrumentHandle, 23.456789, 5);
printf("Waiting for 40 seconds....\n");

Sleep(40000);

printf("f= 33.4567891 MHz, Power = 0 dBm\n");

STATUS = GT2400_SetCW(instrumentHandle, 33.4567891, 0);

STATUS = GT2400_CloseAllConnections();
}
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6.2.4 List Control Functions

The following functions are used to control a list operation. Lists require a number of
parameters to programmed prior to the list execution.

6.2.4.1 About List Operation

The GT2400 list operation is an operation that executes a series of pre-programmed

instrument states (points). The list is capable of storing more than 4000 points. Each point
in the list defines the GT2400 frequency, power, sync. output conditions for a fixed period
of time (step time), as shown in the following figure. A remote command or external TTL
trigger can be used to initiate the list. Only one list is stored in the 2400 at any one time.

List Point 1 List Point 2 List Point 3

RF Output

RF Off
Time

¢—Step Time ‘b‘

Trigger
EXT, GET, SW

- Sync Delay—0|_| |_|
LockiLevel Output

Table 1: List Mode Description

—

|_| Sync Delay Output
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6.2.4.2 Dynamic Range and Step Attenuator Control

Care should be taken whenever programming power lists for 2400's equipped with
Option 26 Step Attenuator, 90 dB step attenuator. Operating a power list with the step
attenuator set to automatic may cause excessive attenuator switching that will shorten
the life the step attenuator. The maximum settable range with the step attenuator set to
manual is 40 dB. Power levels in the list must be within a =20 dB range of the manual
step attenuator setting. When programming a power list, the step attenuator should be
set to manual and set to the middle of the power list operating range.

6.2.4.3 GT2400_DownloadList

Purpose

Download a list to the GT2400 synthesizer. The file can be prepared beforehand by
either MS Excel, or any text editor or Automation Xpress GUI or Automation Xpress
DLL list editing functions.

Syntax

STATUS GT2400_DownloadList(const unsigned long instrumentHandle,
const char listPath[])

Parameter Description

instrumentHandle Input: The unique identification of the instrument.

listPath Input: Complete path (path + list name) of the list being
downloaded to the unit
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6.2.4.4 GT2400_SetRepeatType

Purpose

Set repeat type of the list to be triggered
Syntax

STATUS GT2400_SetRepeatType(const unsigned long instrumentHandle,
const short repeatType)

Parameter Description
instrumentHandle Input: The unique identification of the instrument.
repeatType Input: 0 = single step; 1 = single sweep; 2 = continuous

6.2.4.5 GT2400_SetTriggerType

Purpose

Set trigger type to trigger the list.
Syntax

STATUS GT2400_SetTriggerType(const unsigned long instrumentHandle,
const short triggerType)
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Parameter Description
instrumentHandle Input: The unique identification of the instrument.
triggerType Input: 0 = External trigger; 1 = GET;

2= Software trigger

6.2.4.6 GT2400_SetlListScanDirection

Purpose

Set list scan direction.

Syntax

STATUS GT2400_SetListScanDirection(const unsigned long instrumentHandle,
const short direction)

Parameter Description
instrumentHandle Input: The unique identification of the instrument.
direction Input: 0 = scan from first point to last

point; 1 = scan from last to first
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6.2.4.7 GT2400_SoftwareTrigger

Purpose

Use software to trigger the current list.

Syntax

STATUS GT2400_SoftwareTrigger(const unsigned long instrumentHandle)

Parameter Description

instrumentHandle Input: The unique identification of the instrument.

6.2.4.8 EGT2400_GroupExecutionTrigger

Purpose

Send Group Execution Trigger (G.E.T. is defined in IEEE 488) to all the instruments con-
nected to PC via GPIB.

Syntax
STATUS GT2400_GroupExecutionTrigger(void)

6.2.4.9 GT2400_GetListDataLimit

Purpose
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Get list data limits of the instrument.

Syntax

STATUS GT2400_GetListDataLimit(const unsigned long instrumentHandle,
short *pMaxListPts,

double *pMinStepTime,

double *pMaxStepTime,

double *pMinRFOffTime,

double *pMaxRFOffTime,

double *pMinSyncOutDelay,

double *pMaxSyncOutDelay)

Parameter Description

instrumentHandle Input: The unique identification of the instrument.
pMaxListPts Output: Maximum number of list points allowed (in ms)
pMinStepTime Output: Minimum list step time allowed (in ms)
pMaxStepTime Output: Maximum list step time allowed (in ms)
pMinRFOffTime Output: Minimum list RF off time (in ms)
pMaxRFOffTime Output: Maximum list RF off time (in ms)
pMinSyncOutDelay Output: Minimum list sync out delay (in ms)
pMaxSyncOutDelay Output: Maximum list sync out delay (in ms)
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The following functions allow the application developer to create, and edit lists in RAM.

All list editor functions affect lists stored in a file or in PC RAM. Once a list has been
edited, it can be loaded to the 2400 for execution using the List Control functions.

6.2.5.1 GT2400_LoadListFromFile

Purpose

Load a list from a disk file to PC RAM.

Syntax

STATUS GT2400_LoadListFromFile(const char filename, char errText[])

Parameter Description

filenamel] Input: Name of the file being loaded.

errText Output: If there is an error detected by STATUS, errText will
hold the description of the problems.

6.2.5.2 GT2400_CreateNewlList

Purpose

Create a new list in PC RAM.

Syntax
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STATUS GT2400_CreateNewList(const char listPath[])

Parameter Description

listPath Input: Complete path (path + list name) of the list whose con-
tent is requested.

6.2.5.3 GT2400 SavelistToFile

Purpose
Save a currently active list from RAM to a disk file.
Syntax

STATUS SavelistToFile (const char filename,
char errText[])

Parameter Description
filename Input: File name of list to be saved in.
errText Output: If there is an error detected by STATUS, errText will

hold the description of the problems. If there is no error, err-
Text is empty.

6.2.5.4 GT2400 ActivateAlist

Purpose

Activate the selected list so that the list is ready to respond to a trigger
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STATUS GT2400_ActivateAList(const char listPath[])

Parameter

Description

listPath

Input: Complete path (path + list name) of the list to be acti-
vated.

6.2.5.5 GT2400 GetlListData

Purpose

Get the contents of the selected list from DLL allocated RAM into user application.

Syntax

STATUS GT2400_GetListData(const char listPath[],

double *stepTime,
double *rfOffTime,
double *syncOutDelay,
short*attenSetting,
const char *synclinfo,
double *freq,

double *power,

short *pListLen)
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Parameter Description

listPath Input: Complete path (path + list name) of the list whose con-
tent is requested.

stepTime Output: Step time of all list points (in ms)

rfOffTime Output: RF off time of all list points (in ms)

syncOutDelay Output: Sync out delay (in ms)

synclinfo Output: Sync out pulse information for every list pt

frequency Output: Array of frequencies in the list (in MHz)

power Output: Array of power in the list (in dBm)

pListLen Output: Number of points in the list

6.2.5.6 GT2400_EditAListPoint

Purpose

Edit a selected point in a list.

Syntax

STATUS GT2400_EditAListPoint(const short position
const short insertType,
const char listPath[],
const unsigned char syncOutEnable,
const double frequency,
const double power)
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Parameter Description
position Input: position in the list being edited. 0 < Position <current
list length
insertType Input: Insert Type:
0 = REPLACE,
1= INSERT BEFORE
2= INSERT AFTER
listPath[] Input: Complete path (path + list name) of the list
syncOutEnable Input: Enable/disable sync out pulse generated in the editing
point
frequency Input: Frequency of the point being updated (in MHz)
power Input: Power of the pt being updated (in dBm)
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6.2.5.7 GT2400_EditListPoints

Purpose

Edit multiple selected list points in a list with one function call.

Syntax

STATUS GT2400_ EditListPoints (const short position,

const short insertType,

const char listPath[],

const unsigned char *syncOutEnable,
const double * frequency,

const double * power,

const short listLen,

char errorTxt[])

Parameter

Description

position

insertType

Input: position in the list being edited. 0 < Position <current
list length

Input: Insert Type:

0 = REPLACE,

1= INSERT BEFORE
2= INSERT AFTER

(Note: if insertType = REPLACE, the existing list will be
replaced with the newly created list.)

listPathi]

syncOutEnable

Input: Complete path (path + list name) of the list

Input: Byte array that enables or disables sync out pulse gen-
erated in list.
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Parameter Description

frequency Input: Array of frequency for list points (in MHz)

power Input: Array of power for list points (in dBm)

listLen Input: Number of list points being edited

errText Output: If there is an error detected by STATUS, errText will
hold the description of the problems.

6.2.5.8 GT2400_EditFreqRangeByStepFreq

Purpose

Establish a list or insert a sub-list to an existing list by inputting start frequency, stop fre-
quency, step frequency, and power.

Syntax

STATUS GT2400_ EditFreqRangeByStepFreq(const short position,

const short insertType,

const char listPath[],

const double startFrequency,
const double stopFrequency,
const double stepFrequency,
const double power)
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Parameter Description
position Input: position in the list being edited. 0 < Position <current
list length
insertType Input: Insert Type:
0 = REPLACE,
1= INSERT BEFORE
2= INSERT AFTER
(Note: if insertType = REPLACE, the existing list will be
replaced with the newly created list.)
listPath Input: Complete path (path + list name) of the list
startFrequency Input: start frequency (in MHz)
stopFrequency Input: stop frequency (in MHz)
stepFrequency Input: frequency step (in MHz)
power Input: Power for all list points (in dBm)
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6.2.5.9 GT2400_EditPowerRangeByStepPower

Purpose

Establish a list or insert a sub-list to an existing list by inputting start power, stop power,

step power, and frequency.

Syntax

STATUS GT2400_ EditPowerRangeByStepPower(const short position,

const short insertType,
const char listPath(],
const double startPower,
const double stopPower,
const double stepPower,
const double frequency)

Parameter Description
position Input: position in the list being edited. 0 < Position <current
list length
insertType Input: Insert Type:
0 = REPLACE,
1= INSERT BEFORE
2= INSERT AFTER
(Note: if insertType = REPLACE, the existing list will be
replaced with the newly created list.)
listPath Input: Complete path (path + list name) of the list
startPower Input: start power (in dBm
stopPower Input: stop power (in dBm
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Parameter Description
stepPower Input: step power (in dBm
Frequency Input: Frequency for all list points (in MHz)

6.2.5.10 GT2400_EditFreqRangeByNumOfPts

Purpose

Establish a long list or insert a sub-list to an existing list by inputting start frequency,
stop frequency, power, and number of list points.

Syntax

STATUS GT2400_EdittFreqRangeByNumOfPts(const short position,

const short insertType,
const char listPath[],
const double startFreq,
const double stopFreq,
const double Power,
const short numOfPts)

Parameter Description

position Input: position in the list being edited. 0 < Position <current
list length

insertType Input: Insert Type:

0 = REPLACE,
1= INSERT BEFORE
2= INSERT AFTER

(Note: if insertType = REPLACE, the existing list will be
replaced with the newly created list.)
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Parameter Description

listPath Input: Complete path (path + list name) of the list
startFreq Input: start frequency for range insertion (in MHz)
stopFreq Input: stop frequency for range insertion (in MHz)
power Input: Power for all list points (in dBm)

numOfPts Input: Number of list points being created

6.2.5.11 GT2400_EditPowerRangeByNumOfPts

Purpose

Establish a long list or insert a sub-list to an existing list by inputting start power, stop
power, frequency, and number of list points.

Syntax

STATUS GT2400_EditPowerRangeByNumOfPts(const short position,
const short insertType,
const char listPath[],
const double startPower,
const double stopPower,
const double frequency,
const short numOfPts)
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Parameter Description
position Input: position in the list being edited. 0 < Position <current
list length
insertType Input: Insert Type:
0 = REPLACE,
1= INSERT BEFORE
2= INSERT AFTER
(Note: if insertType = REPLACE, the existing list will be
replaced with the newly created list.)
listPath[] Input: Complete path (path + list name) of the list
startPower Input: start power (in dBm)
stopPower Input: stop power (in dBm)
frequency Input: Frequency for all list points (in MHz)
numOfPts Input: Number of list points being created

6.2.5.12 GT2400_EditRFOffTime

Purpose

Set RF off time of a current list in PC RAM.

Syntax

STATUS GT2400_EditRFOffTime(const double RFOffTime)
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Parameter Description

RFOffTime Input: RF off time for all list points (in ms)
0.1ms <RFOffTime <1000ms

6.2.5.13 GT2400_EditStepTime

Purpose

Set the step time of a current list in PC RAM.

Syntax
STATUS GT2400_EditStepTime(const double stepTime)

Parameter Description

double stepTime Input: Step time of the active list (in ms)
0.15ms <stepTime <1000ms

6.2.5.14 EGT2400_EditSyncOutDelay

Purpose

Set the delay time for the sync out pulse generated

Syntax
STATUS GT2400_EditSyncOutDelay(const double syncOutDelay)
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Parameter

Description

syncOutDelay

Input: Delay time of sync out pulse(in ms)
0.1ms <syncOutDelay <1000ms

6.2.5.15 GT2400 CloseAllLists

Purpose

Remove all existing lists from PC RAM.

Syntax

STATUS GT2400_CloseAllLists(void)

6.2.5.16 GT2400 CloseAList

Purpose

Remove the selected list from PC RAM.

Syntax

STATUS GT2400_CloseAList(const char listPath[])

Parameter

Description

listPath

Input: Complete path (path + list name) of the list being
removed.
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6.2.5.17 GT2400 DeleteAllListPoints

Purpose

Delete all points of a selected list. The contents of the memory are cleared but the
memory is still reserved for this list until the list is closed.

Syntax

STATUS GT2400_DeleteAllListPoints(const char listPath[])

Parameter Description

listPath Input: Complete path (path + list name) of a list.

6.2.5.18 GT2400 DeleteAListPoint

Purpose
Delete a point of a selected list from PC RAM.

Syntax

STATUS GT2400_ DeleteAListPoint(const char listPath[],
const short listPointIndex)

Parameter Description

listPath Input: Complete path (path + list name) of the list whose
point is deleted
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Parameter

Description

listPointindex

Input: Index of the list point being deleted




Amplitude Modulation

6.3 Amplitude Modulation

6.3.0.1 GT2400_SetAMState

Purpose

Set AM on/off.

Syntax

STATUS GT2400_SetAMState(const unsigned long instrumentHandle,
const unsigned short AMState)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
AMState Input: 1= AM is on, 0 = AM is off.
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6.3.0.2 GT2400 SetAMSource

Purpose

Set AM source to external/internal

Syntax

STATUS GT2400_SetAMSource(const unsigned long instrumentHandle,
const short AMSource)

Parameter Description

instrumentHandle Input: The unique identification of the instrument

AMSource Output: 1= External source, 0 = Internal source.

6.3.0.3 GT2400_SetAMExtSensitivity

Purpose

Set AM sensitivity when AM source is external

Syntax
STATUS GT2400_SetAMExtSensitivity(const unsigned long instrumentHandle,
double AMExtSensitivity)
Parameter Description
instrumentHandle Input: The unique identification of the instrument
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Parameter Description

AMEXxtSensitivity Input: AM sensitivity
0.0 < AMEXxtSensitivity < 95.0 (%/V)

6.3.0.4 GT2400_SetAMIntWavefrm

Purpose
Set AM internal waveform
Syntax

STATUS GT2400_SetAMIntWavefrm(const unsigned long instrumentHandle,
const short AMIntWaveform)

Parameter Description

instrumentHandle Input: The unique identification of the instrument

AMIntWaveform Input: AM internal waveform
1=SINE

2 = SQUARE

3 = TRIANGLE

4 = RAMP

5 =NOISE
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6.3.0.5 GT2400 SetAMiIntRate

Purpose

Set AM internal rate
Syntax

STATUS GT2400_SetAMIntRate(const unsigned long instrumentHandle,
const double AMIntRate)

Parameter Description

instrumentHandle Input: The unique identification of the instrument

AMIntRate Input: AM internal rate (in Hz)
0.01 Hz <= AMIntRate <= 1 MHz

6.3.0.6 GT2400_SetAMintDepth

Purpose

Set AM internal depth
Syntax

STATUS GT2400_SetAMIntDepth(const unsigned long instrumentHandle,
const double AMIntDepth)
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Parameter

Description

instrumentHandle

AMIntDepth

Input: The unique identification of the instrument

Input: AM internal depth
0.0 <= AMIntDepth <= 95.0
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6.4 Frequency Modulation

6.4.0.1 GT2400_SetFMState

Purpose

Set FM on/off

Syntax

STATUS GT2400_SetFMState(const unsigned long instrumentHandle,
unsigned short FMState)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
FMState Input: 1 =FM is on, 0 = FM is off

6.4.0.2 GT2400 SetFMSource

Purpose

Set FM source to external/internal

Syntax

STATUS GT2400_SetFMSource(const unsigned long instrumentHandle,
const short FMSource)

140



Frequency Modulation

Parameter Description
instrumentHandle Input: The unique identification of the instrument
FMSource Input: 1 = External source, 0 = Internal source

6.4.0.3 GT2400_SetFMExtMode

Purpose

Set external FM mode to wide or Auto (narrow).

Syntax

STATUS GT2400_SetFMExtMode(const unsigned long instrumentHandle,
const short FMExtMode)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
FMExtMode Input: 1 = WIDE, 0 = NARROW
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6.4.0.4 GT2400_SetFMExtSensitivity

Purpose

Set FM external sensitivity

Syntax

STATUS GT2400_SetFMExtSensitivity(const unsigned long instrumentHandle,
const double FMExtSensitivity, const double freq)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
FMExtMode Input: FM sensitivity(in Hz)

(Please refer to FM sensitivity/deviation
range table in Appendix E)

freq Input: CW frequency (in Hz)

6.4.0.5 GT2400 SetFMIntWavefrm

Purpose

Set FM internal waveform

Syntax

STATUS GT2400_SetFMIntWavefrm(const unsigned long instrumentHandle,
const short FMIntWaveform)
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Parameter

Description

instrumentHandle

FMIntWaveform

Input: The unique identification of the instrument

Input: FM internal waveform
1 =SINE
2 = SQUARE
3 = TRIANGLE
4 = RAMP

6.4.0.6 GT2400_SetFMintDev

Purpose

Set FM internal deviation

Syntax

STATUS GT2400_SetFMiIntDev(const unsigned long instrumentHandle,
const double FMIntDeviation, const double freq)

Parameter

Description

instrumentHandle

FMIntWaveform

Input: The unique identification of the instrument

Input: FM deviation(in Hz)
(Please refer to FM sensitivity/deviation
range table in Appendix E)

freq

Input: CW frequency (in Hz)
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6.4.0.7 GT2400 SetFMintRate

Purpose

Syntax

144

Set FM internal rateSyntax

STATUS GT2400_SetFMIntRate(cont unsigned long instrumentHandle

double FMIntRate)

Parameter

Description

instrumentHandle

FMIntWaveform

Input: The unique identification of the instrument

Input: FM internal rate (in Hz) from 0.1 Hz to1 MHz
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6.5 Pulse Modulation

6.5.0.1 GT2400_SetPMState

Purpose
Set PM on/off

Syntax

STATUS GT2400_SetPMState(const unsigned long instrumentHandle,

const unsigned short PMState

Parameter

Description

instrumentHandle

PMState

Input: The unique identification of the instrument

Input: 1 =PM s on, 0 = PM is off

6.5.0.2 GT2400_SetPMSource

Purpose

Set PM state to internal or external

Syntax

STATUS GT2400_SetPMSource(const unsigned long instrumentHandle,

const short PMSource)
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Parameter Description
instrumentHandle Input: The unique identification of the instrument
PMSource Input: 1 = external source, 0 = internal source

6.5.0.3 GT2400_SetPMExtPolarity

Purpose
Set the polarity for the external Pulse mode.

Syntax

STATUS GT2400_SetPMExtPolarity (const unsigned long instrumentHandle,
const short PMExtPolarity)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
PMExtPolarity Input: 1 = active low, 0 = active high
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6.5.0.4 GT2400_SetPMintTrigSource

Purpose

Set PM trigger source for internal source

Syntax

STATUS GT2400_SetPMiIntTrigSource(const unsigned long instrumentHandle,
const short PMIntSource)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
PMintSource Input: PM trigger source for internal source

1 = external trigger source
0 = internal trigger source

6.5.0.5 GT2400_SetPMintTrigPolarity

Purpose

Set PM trigger polarity for internal source

Syntax

STATUS GT2400_SetPMintTrigPolarity(const unsigned long instrumentHandle,
const short PMIntPolarity)
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Parameter Description
instrumentHandle Input: The unique identification of the instrument
PMintPolarity Input: PM trigger polarity for internal source

1 =falling

0 = rising

6.5.0.6 GT2400_SetPMIntWidth

Purpose
Set pulse width for internal source.

Syntax

STATUS GT2400_SetPMIntWidth(const unsigned long instrumentHandle,
const double PMIntWidth)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
PMIntWidth Input: PM pulse width (in usec)

50 usec <= PMIntWidth <= 1 sec
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6.5.0.7 GT2400_SetPMintDelay

Purpose
Set PM delay for internal source.

Syntax

STATUS GT2400_SetPMIntDelay(const unsigned long instrumentHandle,
const double PMIntDelay)

Parameter Description
instrumentHandle Input: The unique identification of the instrument
PMintDelay Input: PM delay (in usec)

30 usec <= PMIntDelay <= 1.6777215 sec

6.5.0.8 GT2400_SetPMiIntPRI

Purpose

Set PM internal trigger PRI (Pulse Repetition Interval) for internal source.

Syntax

STATUS GT2400_SetPMIntTrigPRI(const unsigned long instrumentHandle,
const double PMIntPRI);
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Parameter

Description

instrumentHandle

PMIntPRI

Input: The unique identification of the instrument

Input: PM PRI (in usec)
30 usec <= PMIntPRI <= 1.6777215 sec




APPENDIX A

Automation Xpress API Error Definitions for

STATUS

Error Code Values Definition

ERROR_NO_CONNECTION -1001 Connection cannot be established
between PC and the instrument.

ERROR_INVALID_INSTR_HANDL -1002 The input instrument handle is invalid.

E

ERROR_INVALID_ADDR -1003 The input GPIB address is invalid or the
specified GPIB address has been
opened.

ERROR_GPIB_ADDR_OUT_RANG -1004 The input GPIB address is out of valid

E range (1 to 30)

ERROR_INVALID_COMPORT -1005 The input COM port number is invalid.

ERROR_FAIL_SAVE_REG -1006 Failure to save data into Windows regis-
try.

ERROR_FAIL_OPEN_REG -1007 Failure to load data from Windows regis-

try.
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Error Code Values Definition

ERROR_NO_MEMORY -1008 Failure to load data from Windows regis-
try.

ERROR_ATTEN_OUT_RANGE -1009 Attenuation is out of valid range.

ERROR_ATTEN_NOT_INSTALLED -1010 Attenuator is not installed in the instru-
ment.

ERROR_SYNC_DELAY_OVER_RA -1011 Sync out delay is out of valid range.

NGE

ERROR_RF_OFF_TIME_OVER_R -1012 RF off time is out of valid range.

ANGE

ERROR_RF_OFF_OVER_STEP_TI -1013 RF off time exceeds list step time.

ME

ERROR_LIST_NOT_EXIST -1014 The input list path does not exist.

ERROR_SOURCELIST_NOT_EXIS -1015 The source list does not exist.

T

ERROR_DESTLIST_NOT_EXIST -1016 The destination list does not exist.

ERROR_FREQ_OUT_RANGE -1017 Input frequency is out of valid range.

ERROR_BAD_FREQ_INPUT -1018 Start frequency is greater than stop fre-
quency in list range insertion.

ERROR_STEP_OUT_RANGE -1019 Step frequency is out of valid range in list
range insertion.

ERROR_STEPTIME_OUT_RANGE -1020 List step time is out of valid range.

ERROR_POWER_OUT_RANGE -1021 Input power is out of valid range.

ERROR_UNKNOWN_INSERT_TY -1022 List insertion type is not valid.
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Error Code Values Definition

ERROR_INVALID_IN_POSITION -1023 List insertion position for new list points
are not valid.

ERROR_LISTPT_EXCEED_LIMIT -1024 Total number of list points exceeds the
limit.

ERROR_INVALID_FILE_NAME -1025 Input file name is invalid.

ERROR_READ_FILE -1026 Unable to read the input file.

ERROR_INVALID_FILE -1027 Input file is invalid. It may be caused by
incorrect file format.

ERROR_WAIT_EV_TIMEOUT -1028 Time out before operation completed

ERROR_BAD_POWER_INPUT -1029 Input power is invalid.

ERROR_INVALID_COMMAND -1030 Input command is invalid.

ERROR_INVALID_EVENT -1031 Input event is invalid

ERROR_NULL_PTR -1032 Function-call failure caused by passing a
null pointer.

ERROR_POW_OFFSET_OUT_RA -1033 Power offset is out of valid range.

NGE

ERROR_POW_SLOPE_OUT_RAN -1034 Power slope is out of range

GE

ERROR_INVALID_INPUT -1035 Input data is invalid.

ERROR_DB_SYNCHRONIZATION -1036 Unable to synchronize the instrument

database in PC.
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Error Code Values Definition

ERROR_BAD_READING -1037 Invalid data is returned from the instru-
ment.

ERROR_FUNC_STACK_OVERFLO -1038 Stack buffer for function calls is overflow.

w

ERROR_EMPTY_STACK_BUFFER -1039 No data is stored in function-call buffer.

ERROR_CMD_STACK_OVERFLO -1040 Stack buffer for commands is overflow.

w

ERROR_EMPTY_COMMAND_BUF -1041 No data is stored in command buffer.

FER

ERROR_INVALID_AUTO_PATH -1042 Failed to find Auto Programmer directory.
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